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About This Guide

This User Guide describes Cisco ANA NetworkVision and its use in network based environments. It is 
intended for use by network administrators and anyone else responsible for the management, fulfillment, 
planning and assurance of the integrity of network resources. 

It includes the following chapters:

• Chapter 1, “Cisco ANA Client Overview” describes the Cisco ANA Client application suite. In 
addition, it provides a brief explanation of the terms used in this guide.

• Chapter 2, “Getting Started” describes the Cisco ANA NetworkVision working environment and 
how to access the Cisco ANA NetworkVision tools and commands. In addition, it describes how to 
customize Cisco ANA NetworkVision's startup and display options.

• Chapter 3, “Working with Cisco ANA NetworkVision Tables” describes how to work with 
Cisco ANA NetworkVision's tables and how to perform general Cisco ANA NetworkVision 
functions, for example, printing, filtering and saving a map image.

• Chapter 4, “Working with Cisco ANA NetworkVision Maps” describes how to use Cisco ANA 
NetworkVision to perform various operations with the network maps including adding and 
aggregating devices.

• Chapter 5, “Viewing Device Properties” describes how to view the properties of a device and 
provides a description of these properties. In addition, it provides a brief description on Virtual 
Network Element (VNE) properties.

• Chapter 6, “Viewing Network Device Inventory” describes how to view the physical and logical 
inventory of devices and the relationship between them. In addition, it describes opening the port 
utilization graph, the DLCI/VC/Cross Connect tables and managing port alarms.

• Chapter 7, “Working with Links” describes how to view information about the physical links 
between ports. In addition, it describes adding links between devices.

• Chapter 8, “Working with Tickets” describes how Cisco ANA NetworkVision correlates alarms and 
how to view the tickets and tickets properties, including correlated alarms, active alarms and alarm 
history. In addition, it describes ticket management and the different ways in which a ticket is 
displayed in the ticket pane depending on the status/severity of the alarm.

• Chapter 9, “Working with Cisco ANA PathTracer” describes how to view a network path between 
two network objects using Cisco ANA PathTracer, in a circuit-switched network, like Frame Relay 
or ATM, or in packet-switched networks like Ethernet and IP. In addition, it describes the 
Cisco ANA PathTracer working environment. 

• Chapter 10, “Working with Business Tags” describes how to manage and view business tag 
information. 
ix
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About This Guide
    Obtaining Documentation, Obtaining Support, and Security Guidelines
• Appendix A, “Icon Reference” provides a quick reference guide to the Cisco ANA NetworkVision 
icons.

Note Changes to the registry should only be carried out with the support of Cisco Professional Services.

Related Documentation
For more detailed information, refer to the following publications: 

• Cisco Active Network Abstraction Managing MPLS User Guide

• Cisco Active Network Abstraction EventVision User Guide

• Cisco Active Network Abstraction Administrator Guide

• Cisco Active Network Abstraction Command Builder User Guide

• Cisco Active Network Abstraction Installation Guide

• Cisco Active Network Abstraction Customization User Guide

Obtaining Documentation, Obtaining Support, and Security 
Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback, 
security guidelines, and also recommended aliases and general Cisco documents, see the monthly 
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical 
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
x
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C H A P T E R 1

Cisco ANA Client Overview

This chapter provides an overview of the Cisco ANA Client application suite, and in addition, it provides 
a brief explanation of the basic concepts, terms and acronyms used in this guide.

• Cisco ANA NetworkVision, page 1-1, provides a description of Cisco ANA NetworkVision, 
including the Cisco ANA Soft Properties Manager and the Cisco ANA Command Builder.

• Events, Tickets and Alarm Definitions, page 1-3, defines events, tickets and alarms.

• Basic Terminology, page 1-4, defines the terminology used throughout this guide.

Cisco ANA provides a suite of GUI tools that offer an intuitive interface for managing the network and 
services and performing the required system administration activities. The Cisco ANA Client 
application suite consists of the following:

• Cisco ANA NetworkVision, as described in Cisco ANA NetworkVision, page 1-1.

• Cisco ANA EventVision. For more information, refer to the Cisco Active Network Abstraction 
EventVision User Guide.

• Cisco ANA Manage. For more information, refer to the Cisco Active Network Abstraction 
Administrator Guide.

Note Changes to the registry should only be carried out with the support of Cisco Professional Services.

Cisco ANA NetworkVision
Cisco ANA NetworkVision is the main GUI for Cisco ANA. It is a surveillance tool providing total 
visibility for multi-vendor, multi-tier, multi-technology networks. It also supports fault and 
configuration functionality. The highly optimized, customizable GUIs enable constant, system-wide 
surveillance of the network and service states, down to the node level.

Cisco ANA NetworkVision supports the creation of multiple network maps in order to represent specific 
network views. Views can cover specific network segments, customer networks, or any other mix of 
network elements desired. Once the maps have been created, they are available for all connecting clients 
(with support for fine grained access privileges). 

Cisco ANA NetworkVision enables you to:

• View network inventory and multilayer connectivity

• Troubleshoot, monitor and manage Network Elements (NEs)
1-1
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    Cisco ANA NetworkVision
• Model and view network maps maintaining up to date topological information on device 
connections, traffic and routes

The NetworkVision maps based on Cisco ANA’s representation of VNEs (Virtual Network Elements) 
provides a graphic display of active faults and alarms and serves as an easy access point for activation 
of services. Cisco ANA provides rich functionality for displaying and managing the network maps by 
providing:

• Multiple concurrent maps per user.

• Easily customizable hierarchy of nested sub-maps, NE aggregations and business tags with easy 
navigation up and down the hierarchy.

• Dual views of the network in a hierarchical tree, as well as in topological maps, including all 
network connections.

• NEs and links using color cues and graphic symbols to indicate status and alarms.

• Every NE (either from the tree or map) allows mouse point-and-click drill-down providing detailed 
internal physical and logical inventory information.

NetworkVision is also the launch point for related tools such as the Command Builder, Soft Properties 
Manager and the Cisco ANA PathTracer.

For specific details on using Cisco ANA NetworkVision when working with MPLS VPN service 
network maps, refer to the Cisco Active Network Abstraction Managing MPLS User Guide.

Cisco ANA PathTracer
Cisco ANA PathTracer enables end-to-end route tracing to be performed with informative performance 
information displayed simultaneously for the multiple networking layers. Upon receiving a path's start 
and endpoint, Cisco ANA PathTracer visually traces the route through the network. For more 
information about Cisco ANA PathTracer, see Chapter 9, “Working with Cisco ANA PathTracer”.

SoftProperties Manager
The Cisco ANA Soft Properties Manager enables you to manage soft properties and Threshold Crossing 
Alarms (TCA). 

The Soft Properties Manager allows you to extend the set of supported properties for each Network 
Element (NE), by adding soft properties to the Virtual Network Elements (VNEs). These properties 
extend the Cisco ANA IMO and are available through the client GUI as well as through the BQL API. 

Soft properties are retrieved from the NE using SNMP, Telnet/SSH or TL1.

In addition, alarm thresholding enables the user to constantly monitor selected properties and generate 
an alarm every time they cross a user-defined threshold or violate a condition.

The Soft Properties Manager tool is typically used by integrators and any other users who want to 
manage the soft properties and TCA alarms that are executed within the Cisco Active Network 
Abstraction (ANA) platform.

For more information on the Cisco ANA Soft Properties Manager, refer to the Cisco Active Network 
Abstraction Customization User Guide.
1-2
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Cisco ANA Command Builder
The Cisco ANA Command Builder enables you to execute a programmable sequence of SNMP or Telnet 
command lines. These commands can include data properties taken from the Cisco ANA information 
model (built-in), as well as user-defined input parameters entered during runtime. 

The Command Builder is launched from a Managed Element (Cisco ANA modeled VNE) such as a port, 
typically from the NetworkVision’s Inventory window. The Managed Element will then be used to 
develop and test the command. Once the command has been completed it can be published and attached 
to a wider scope of Managed Elements.

For more information on the Cisco ANA Command Builder, refer to the Cisco Active Network 
Abstraction Command Builder User Guide.

Events, Tickets and Alarm Definitions
Cisco ANA NetworkVision displays Ticket information created by Cisco ANA’s discovery and 
correlation of system and network events and alarms. 

In the Cisco ANA context, the relationship between events, alarms and tickets is as follows:

• An event is an indication of a distinct “activity” that occurred at a specific point in time. Events are 
derived from incoming traps or notifications and from detected status changes. Examples of events 
include:

• Port status change

• Route entry drop

• Device reset

• Device becoming reachable

• User acknowledgement of an alarm

Events are written to the ANA database once and never change.

• An alarm represents a fault scenario that occurs in the network or management system. Alarms 
represent the complete fault lifecycle, from the time that the alarm is opened (when the fault is first 
detected) until it is closed and acknowledged. Examples of alarms include:

– Link down

– Device unreachable

– Card out

– Root cause correlation is determined between alarms (namely, between event sequences). It 
represents a causal relationship between an alarm and the consequent alarms that originate from 
it.

For example, a Card-out alarm can be the root cause of several link down alarms, which in turn can 
be the root cause of multiple Route-lost and Device unreachable alarms, and so on (a consequent 
alarm can serve as the root cause of other consequent alarms).

• A ticket represents the complete alarm correlation tree of a specific fault scenario. It can be also 
identified by the topmost (“root of all roots”) alarm. Cisco ANA NetworkVision’s Ticket Properties 
dialog box displays only tickets, but allows drilling down to view the consequent alarm hierarchy.
1-3
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From an operator’s point of view, the managed entity is always a complete ticket. Operations such 
as Acknowledge, Force-Clear or Remove are always applied to the whole ticket. The ticket also 
assumes an overall, propagated severity (severity equal to the highest severity of the constituent 
alarms).

Basic Terminology
This section describes the terminology used throughout this guide.

Acronyms

The following acronyms are used throughout this guide:

Basic Concepts and Terms

This section provides a description of the concepts and terms used throughout this guide.

Table 1-1 Acronyms

Acronym Full Name Description

General

ANA Active Network Abstraction Reference for the entire Cisco ANA solution.

VNE Virtual Network Element Reference to a network and device agent

Client

ANA Active Network Abstraction User CLI

EV Cisco ANA EventVision

NV Cisco ANA NetworkVision

VNE

DC Device Component

NE Network Element

AVM Autonomous Virtual Machine

Table 1-2 Basic Concepts and Terms

Aggregation/ Aggregated Node Managed Element

Alarm Network Object

Business Element Physical Element

Business Tag Physical Link

Business Link Provider

Device/Network Element (NE) Severity Propagation

Device/Network Element Components Subscriber

Event Ticket

Link Virtual Cloud / Unmanaged Network
1-4
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Logical Element VPN

Logical Link

Table 1-3 Definitions

Term Description

Event An event is an indication of a discrete “activity” that occurred at a 
specific point of time. Events are determined from incoming 
traps/notifications and from detected device changes.

Alarm A series of events having the same source and type.

Ticket A ticket represents a faulty scenario that occurs in the network or 
management system. Tickets represent the complete fault lifecycle, 
from the time that the ticket is opened (when the fault is first 
detected) until it is closed and acknowledged. It is a correlation of 
multiple alarms (namely, event sequences). It represents a causal 
relationship between an alarm and the consequent alarms that 
originated from it. It is identified by the root cause alarm.

Only tickets are displayed in Cisco ANA NetworkVision’s ticket 
pane in the Cisco ANA NetworkVision window. Tickets are also 
displayed in the Inventory Properties window. Drill down to view the 
consequent alarm hierarchy when opening the ticket’s properties.

Severity 
Propagation

The network objects’ calculated status is propagated from the 
source/children (namely, the network element component) to the 
final destination (namely, the network element and tree) via defined 
relationships.

Aggregation/ 
Aggregated Node

Zero or more map elements joined together as an aggregation.

Physical Element A user named physical component/device existing in the network.

Logical Element A user named logical component, for example, a routing table.

Business Element Cisco ANA supports the mapping of service-related information to 
the network resources. This mapping is achieved using a business 
element that is a wrapper to a network element or service. The VPN 
is a business element, which represents a set of interconnected Sites 
forming a single virtual private network over a public network. 
Cisco ANA organizes the business elements in a way that creates a 
containment hierarchy that reflects the VPN structure. 

Managed Element Anything managed by the system, usually a component managed by 
the VNE, for example, a device, cloud, ICMP VNE.

Link A physical or logical link between:

• Two devices in the network

• A device and an aggregation

• Two aggregations

Physical Link A link between physical Network Objects, for example, a connection 
between two physical ports.

Table 1-2 Basic Concepts and Terms (continued)
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Logical Link An association between two logical elements (based on a chain of 
physical elements), for example, a tunnel.

Business Link An association between:

• Logical (protocol oriented configuration) to physical

• Logical to logical

• Business link to anything

For example, in a VPN an association between the physical IP 
interface and VRF (which is the associated routing table).

Device/Network 
Element (NE)

A user named physical component/device existing in the network.

Device/Network 
Element 
Components

A component of a network element, for example, a port, routing table 
and so on.

Network Object Network Objects include network element components, network 
elements and links.

Virtual Cloud / 
Unmanaged 
Network

Virtual clouds are used for representing unmanaged network 
segments and are displayed as a cloud. Cisco ANA establishes if 
network problems emanate from the unmanaged network, namely, 
the cloud.

VPN The VPN is a business element, which represents a set of 
interconnected Sites forming a single virtual private network over a 
public network.

Business Tag A “business” tag is a record that points to a network object. Each 
business tag has a “key” field, which is a unique identifier for the 
entity and its name (refer to Business Element).

There are three types of tags, namely, subscriber, provider, and label. 
Business tags are stored in the Cisco ANA Gateway database.

Provider The party providing the service.

Subscriber The party receiving the service.

Table 1-3 Definitions (continued)

Term Description
1-6
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C H A P T E R 2

Getting Started

This chapter describes the Cisco ANA NetworkVision working environment and how to access the 
Cisco ANA NetworkVision tools and commands.

The Cisco ANA NetworkVision window provides access to all Cisco ANA NetworkVision's 
functionality.

• Starting Cisco ANA NetworkVision, page 2-1 describes how to login to Cisco ANA NetworkVision.

• Cisco ANA Security, page 2-3 describes the enhanced security provided when working with and 
managing the Cisco ANA system.

• Cisco ANA NetworkVision Window, page 2-5 describes the Cisco ANA NetworkVision window, 
including the tree pane, workspace and properties pane, ticket pane, toolbar and menus.

• Changing a User Password, page 2-31 describes how the user can change their login password.

• Selecting Cisco ANA NetworkVision Map and Alarm Options, page 2-31 describes how to 
customize Cisco ANA NetworkVision’s startup and display options.

• Logging Out, page 2-32 describes how to log out of Cisco ANA NetworkVision.

Starting Cisco ANA NetworkVision
This section provides instructions for launching the Cisco ANA NetworkVision application. Cisco ANA 
NetworkVision is password protected to ensure security. Before you start working with Cisco ANA 
NetworkVision make sure you know your username, password and the Cisco ANA Gateway IP address 
or hostname that you require.

Note If a user does not login to the Cisco ANA Manage, NetworkVision or EventVision applications during a 
specified period of time (the default is one month) the user’s account will be automatically locked. The 
default period can be changed per user in Cisco ANA Manage. The period of time is measured from the 
time the user last logged out of any of the Cisco ANA Client applications.

The security level required in order to perform the specific Cisco ANA NetworkVision function is 
indicated in this User Guide by means of icons. 

For more information about the icons used, see Cisco ANA Security, page 2-3.
2-1
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To start Cisco ANA NetworkVision:

Step 1 From the Start menu, select the Programs folder, then Cisco ANA/Cisco ANA NetworkVision. 

or

Click on the Cisco ANA NetworkVision quick launch icon in the taskbar. The Cisco ANA 
NetworkVision Login dialog box is displayed.

The last four Cisco ANA Gateways to which the user logged in successfully are displayed in the Host 
dropdown list. The list is displayed in chronological order with the most recent Cisco ANA Gateway 
displayed at the top of the list.

Step 2 Enter your User Name, and Password. 

Step 3 Enter the required Cisco ANA Gateway’s information in the Host field, as an IP address or hostname,

or

Select a Cisco ANA Gateway from the Host dropdown list.

Note The Cisco ANA Gateway IP address or hostname that was used when you last logged in is 
automatically displayed at the top of the Host dropdown list.

Note Make sure that you use the leading IP address (the IP on which the Cisco ANA Gateway was 
configured) when logging in to the system.

Step 4 Click OK. The Cisco ANA NetworkVision window is displayed.

Note When logging in there is an update on minor fixes.

Note The Cisco ANA NetworkVision window appears empty when it is opened for the first time. You 
can create a new map and/or open a map that has been previously saved, see Chapter 4, “Working 
with Cisco ANA NetworkVision Maps”, in order to view a network.

After logging in to Cisco ANA NetworkVision and launching the application, you may customize 
Cisco ANA NetworkVision’s Options, namely, Start / Display /Audio settings, for example, you can:

• Load the workspace with information when starting NetworkVision

• Display network elements in the NetworkVision Map and tree panes

• Configure audio responses when different alarms are triggered

For more information on how to customize Cisco ANA NetworkVision’s startup and display options, see 
Selecting Cisco ANA NetworkVision Map and Alarm Options, page 2-31. 
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Cisco ANA Security
Cisco ANA provides enhanced security when working with and managing the Cisco ANA system. Users 
are assigned permission levels for an operational scope, which enable them to perform only the functions 
assigned to the scope and defined security level. A user can be assigned more than one security level.

Permission

The user’s ability to perform certain tasks. There are two types of permissions, namely, default and NE 
related. 

• Default—The default permission only applies to the activities that are related to GUI functionality, 
not the activities related to network elements. For example, a user with the default permission 
Viewer can view maps and the Device List. For more information, refer to Cisco Active Network 
Abstraction Administrator’s Guide.

• Network Element—The NE related permission enables the administrator to group a collection of 
managed network elements together (in Cisco ANA Manage) in order to enable the user to view 
and/or manage the NEs based on the user’s role or permission. After the user is allocated a scope 
(list of network elements) and a role, the user can then perform various activities on the network 
elements, for example, manage alarms in Cisco ANA NetworkVision. For more information, refer 
to Cisco Active Network Abstraction Administrator’s Guide.

Roles

Cisco ANA implements a security engine that combines a role-based security mechanism that is applied 
on scopes of network elements granted per user. The system supports user accounts creation, multiple 
network element scope definition and a set of five pre-defined roles for security and access control to 
allow different system functions:

This guide uses the icons displayed above (listed in order from lowest to highest security level) to 
indicate the security level required in order to perform specific Cisco ANA NetworkVision functions.

Note A user with a higher security level can perform all the Cisco ANA NetworkVision functions assigned to 
a user with a lower security level.

Table 2-1 Security and Access Control Roles

Viewer—Read only access to the network and to non-privileged system functions.

Operator—Configure business tags and perform most day-to-day operations.

Operator Plus—Able to fully control alarm life cycle and create maps.

Configurator—Activate services, and configure the network.

Administrator—Manage the system configuration and security.
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Each user is assigned a permission level for an operational scope, which enables the user to perform 
certain tasks. Every user has a private username and password. A user can login from any workstation 
with the user’s own set of permissions and operational scope.

When a user does not have the required permission level to perform a function the appropriate menu 
option or button is disabled. 

The administrator is responsible for defining the types of activities that the user can view and perform 
using Cisco ANA Manage.

For more information about user security and defining operational scopes, refer to the Cisco Active 
Network Abstraction Administrator’s Guide.

Roles can be granted per scope or at an application level (default permission), namely, all the activities 
that are related to GUI functionality, not the activities related to devices. The default permission 
includes:

• Application login.

• Manage alarms in Cisco ANA NetworkVision.

• Manage maps—Creating, deleting, and opening.

• Map manipulation—Arrange map, including, aggregations, adding NEs, NEs placement in map, 
map background and so on.

• Business tag management.

Scopes

A scope is a named collection of managed network elements that have been grouped together in order to 
allow a user to view and/or manage the network elements provided a given role. Grouping can be based 
on geographical location, network element type (such as DSLAM, router, SW, and so on), network 
element category (such as access, core, and so on) or any other division according to the network 
administrator’s requirements.

Using NetworkVision, a user that has been assigned a scope can view and/or manage the NEs within this 
scope according to the role assigned to the user as per the scope. The user cannot view any information 
regarding NEs that are outside the user’s scope, including basic properties, inventory, and alarms.
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Cisco ANA NetworkVision Window
The Cisco ANA NetworkVision window with an open map is displayed below. 

Figure 2-1 Cisco ANA NetworkVision Window

The Cisco ANA NetworkVision window is divided into three main areas or panes, as follows:

• Tree Pane

• Workspace, including the map pane, device view and links view.

• Ticket Pane

1 Menu bar

2 Toolbar

3 Workspace

4 Status bar

5 Ticket pane

6 Hide/display ticket pane

7 Tree pane
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Note The ticket pane can be displayed or hidden by clicking the arrows below the tree pane.

The status bar which is the horizontal area at the bottom of the main Cisco ANA NetworkVision window 
and other Cisco ANA NetworkVision windows provides information about the current state of what you 
are viewing in the window relating to the application. There are two states, namely, Connected and 
Reconnecting. It also displays what is happening to the command that has been sent while the application 
is waiting for an answer.

In addition, the memory utilization bar in the status bar displays the amount of memory used by the 
client. By default if memory utilization exceeds 60% it is colored yellow and if it exceeds 80% it is 
colored red. The default percentage and color values can be configured in the registry.

Dragging the borders of the Cisco ANA NetworkVision window adjusts the size of each pane. The tree 
pane, and workspace are correlated; this means that selecting an option in the one pane affects the 
information displayed in the other pane.

Some of the functions that the Cisco ANA NetworkVision window enables you to perform are:

• View the network.

• View device properties.

• View physical and logical inventory information.

• View a complete list of the physical links and their status.

• View link properties.

• View and manage tickets.

Tree Pane
The tree pane displays a tree-and-branch representation of the network elements and aggregations 
defined for the loaded map.

The highest level of the tree pane displays the map name, for example, the name of a geographic region, 
country or a state. When the map name is changed, the Cisco ANA NetworkVision window is updated. 
The new map name is displayed at the top of the tree pane and in the title bar of the window between 
brackets.

The lowest level of the tree pane displays a single NE, for example, a router and the device name or the 
name of the business tag. The tool tip displays the NE name, NE type and IP address. For information 
about the status of Network Objects, see Status of Network Objects, page 2-15.

Workspace
The workspace enables you to view and modify low-level information. It includes the following areas: 

• Map Pane—Displays managed network elements on a geographical map. For more information see 
Map Pane, page 2-7.

• Device View—Displays the details of the network devices contained in the currently selected 
hierarchy or sub-network (map), for example, the IP Address and Vendor. For more information see 
Device View, page 2-9.

• Links View—Displays a complete list of the links shown in the map pane and their status. For more 
information see Links View, page 2-11.
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When a user switches between the map pane, device view and links view the following is preserved:

• The network elements and/or links selected

• The sorting preferences

• The filtering preferences, as defined using:

– The Map Options dialog box, see Filtering Links According To Type, page 4-17.

– The Filter dialog box, see Defining a Filter, page 3-2.

– The links view collection method, see Filtering Links Using the Collection Method, page 7-10.

Map Pane

Cisco ANA NetworkVision displays managed network elements in the map pane. In addition, the map 
pane displays the links or aggregated links and relationships between the network devices, aggregated 
nodes (topology), and networks on a geographical map.

Each NE is displayed using a NE icon, the color of which reflects severity, as described in the Map Pane, 
page 2-7. In addition, a management state or alarm icon is displayed together with the IP address. For 
more information see Appendix A, “Icon Reference”. The tool tip displays the NE name, NE type and 
IP address.

The links or aggregated links that are presented in the map pane:

• Display arrowheads if they are unidirectional

• Do not have arrowheads if they are bi-directional

Note A maximum number of 4000 links can be displayed in the map (configurable in the registry). If this 
number is exceeded a warning message is displayed and all the lines (links) are removed from the map 
(they are still displayed in the links view). In addition, the map is surrounded by a red border. Filtering 
the links may reduce the number of links so that the client can return to a normal state.

The links display tool tips that provide you with information regarding the number of links and partially 
describe the list of links. Physical links are highlighted in bold. 

Note If there is a link filter applied to the map then the links tool tip displays only the relevant links.

The map pane enables network objects to be viewed down to the device level. An example of the map 
pane is displayed in the Cisco ANA NetworkVision Window, page 2-5.

The devices can be moved manually on the geographical map by dragging the required device. In 
addition, clicking Layout on the toolbar or using the Zoom tools in the menu bar can change the way 
that the devices are displayed on the map.

Note Click Map pane on the toolbar to display the map pane in the Cisco ANA NetworkVision window.

Some of the functions that can be performed using the right-click shortcut menu in the map pane are:

• View device inventory. For more information see Chapter 6, “Viewing Network Device Inventory”.

• Aggregate devices. For more information see Chapter 4, “Working with Cisco ANA NetworkVision 
Maps”.
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• Create and attach business tags. For more information see Chapter 10, “Working with Business 
Tags”.

• Create and view tickets. For more information see Chapter 8, “Working with Tickets”.

• Change the view and content of network maps. For more information see Chapter 4, “Working with 
Cisco ANA NetworkVision Maps”.

• Communicate with network devices. For more information see Chapter 4, “Working with 
Cisco ANA NetworkVision Maps”.

• Configure the topology. For more information see Chapter 7, “Working with Links”.

• View device information, namely, device properties. For more information see Chapter 5, “Viewing 
Device Properties”.

Note Most of these functions can also be performed from the tree pane’s right-click shortcut menu.

When working with this functionality for MPLS VPN networks, refer to the Cisco Active Network 
Abstraction Managing MPLS User Guide.

The following icons are used to display the network elements in the Cisco ANA NetworkVision 
window’s tree pane and map panes:

Table 2-2 Device Icons

Icon Device

Unmanaged Network

Network, sub-network or logical aggregation

Router 

Generic SNMP 

Ethernet Switch 

DSLAM 

ATM switch 

BRAS

Ping VNE

Viewable by a user with a higher permission level

Ghost device
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Note When Cisco ANA NetworkVision detects a network device for which there is not enough information 
available, the device is displayed as a ghost device on the map. In this case, the user is unable to view 
the ghost device's properties or communicate with the ghost device. When the ghost device's information 
is updated, its icon is replaced with the relevant device icon and all the related device information and 
communication become available.

The following colors are used to display the severity (or propagated severity) of a network device when 
displayed in the map pane, tree pane and ticket pane:

• Red—Critical.

• Orange—Major.

• Yellow—Minor.

• Sky Blue—Warning.

• Green—Cleared/Normal/OK.

• Dark Blue—Information.

Note The Information severity does not affect the severity (color) of the network object.

• White—Indeterminate.

The same coloring conventions apply to the link severity displayed in the map pane and links view. 

Note The color of a selected link is customizable. The default color is blue.

When an aggregated node is selected in the tree pane, the map pane displays the devices contained within 
the aggregated node and the relationships between them.

For more information about how the status of a network device is displayed in the map pane, see Status 
of Network Objects, page 2-15.

Device View

The device view displays the details of the network devices contained in the currently selected hierarchy 
(map), for example, the IP Address and Vendor.

Note • Click Device View on the toolbar to display the device view in the Cisco ANA NetworkVision 
window.

• Locked devices only display Managed Element information and the locked device icon.

• Use the scroll bar to view all the columns in the table.

The following columns are displayed in the device view:

• Managed Element—The device name of the element managed by Cisco, as defined in Cisco ANA 
Manage. It also displays a device icon, the color of which reflects severity. In addition, the 
management state or an alarm icon is displayed.
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• IP Address—The IP address used for managing the device as a hyperlink that opens the properties 
of the relevant device.

• System Name—The system name of the device, as defined in the device's MIB, for example, Router. 
If it is Telnet then it is the prompt.

• Communication State—The communication status with the device or VNE, for example, Device 
Unreachable. For more information see Management State, page 2-17.

• Investigation State—The investigation status of the VNE, for example, normal, initializing, 
maintenance or unsupported.

• Element Category—The device category, for example, Router or ATM-Switch.

• Element Type—The device type (manufacturer name), for example, Cisco 7200.

• Vendor—The vendor name.

• Up Since—The date and time when the device was last reset.

• Sending Alarms—The status of alarms on the device, namely, enabled (true) or disabled (false) in 
the Cisco system. This can be enabled on only part of the device.

Warning There is an option to add the System Description, Location and Contact columns to the device view, 
however, this will increase memory consumption. Changing these settings must be done with the 
support of Cisco Professional Services.

Note Clicking on a red triangle displayed in a cell expands the cell to display all the information. You can also 
use a tool tip to view all the information.

The following buttons are displayed in the device view toolbar:

See Chapter 3, “Working with Cisco ANA NetworkVision Tables”, for more information about filtering 
and finding details about a device displayed in Cisco ANA NetworkVision’s tables, and for the keyboard 
shortcuts used for accessing table functionality.

Table 2-3 Device View Toolbar

Export to CSV—Enables you to export the information displayed in the 
device view. Either the selected row(s) is exported or when nothing is selected 
the entire table is exported.

Sort Table Values—Enables you to sort the information displayed in the 
device view, for example, according to element category.

Filter—Enables you to define a filter for the tickets displayed data displayed 
in the table according to a selected column. 

Note When a filter is applied the Set Selection Filter button is activated.

Previous Selection Filter—Enables you to undo the last applied filter 
selection. 

Rewind All—Enables you to undo previous filter selections, and displays all 
the original information in the device view. 
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Some of the functions that can be performed using the right-click shortcut menu in the device view are:

• View device information, namely, device properties. For more information see Chapter 5, “Viewing 
Device Properties”.

• View device inventory. For more information see Chapter 6, “Viewing Network Device Inventory”.

• Configure the topology. For more information see Chapter 7, “Working with Links”.

• Configure and view Business Tag information. For more information see Chapter 10, “Working with 
Business Tags”.

Note Clicking on a header in the device view sorts the information displayed, for example, according to an 
Element Category.

Links View

The links view is displayed in the Cisco ANA NetworkVision window when clicking  on the toolbar.

When the user views a map, it may, for example, have many links or aggregated links. This may make it 
difficult for the user to view the links that are required. The links view enables the user to clearly view 
the required links, and in addition the user can easily search for a specific link. The links view provides 
the user with an easy to access complete list of the various types of links displayed on the map (the links 
view is context sensitive). The user can also view the status of the link. 

Note You can view and filter the links according to type using the Map Options dialog box. For more 
information see Filtering Links According To Type, page 4-17.

Note Business links are part of the links view. For information about business links, refer to the Cisco Active 
Network Abstraction Managing MPLS User Guide.

Any links that are added or removed from the map are automatically added or removed from the links 
view provided they have not been filtered out. 

The links view is selection sensitive, namely, the links displayed in the links view depend on the context 
selected in the tree pane or map pane. For example, if an aggregated node or aggregated link is selected 
then the links of the selected context are displayed in the links view.
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The links view is displayed below.

Figure 2-2 Links View

Note An external link has a gray cell background in the table, and the Inventory window can be opened by 
clicking the hyperlink. For more information about external links, see Working in Links View, page 7-8.

The following columns are displayed in the Links View window:

• Context—The name of the map, aggregated node or sub-aggregated node containing the link.

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm on 
the link. This indicates the impact of the alarm on the network. For more information about severity, 
see Map Pane, page 2-7.

• A End-Point—The device or site that is the source of the link as a hyperlink to the inventory of the 
device or site.

• Bi Directional—The direction of the link, namely, true (bi-directional) or false (unidirectional). If 
the link is unidirectional (false) then the traffic is from A->Z.

• Z End-Point—The device or site that is the destination of the link as a hyperlink to the inventory 
of the device or site.

• Link Type—The type of link, for example, Physical Layer, VPN or MPLS.

Note Clicking on a header in the links view sorts the information displayed, for example, according to 
Severity.
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The following additional buttons are displayed at the top of the links view (navigation sensitive) and 
enable you to filter the links using the collection method:

For more information about filtering and sorting links in links view, see Working in Links View, 
page 7-8.

Ticket Pane
When Cisco ANA detects faulty behavior in the network, the VNEs and their internal Device 
Components initiate an internal, end-to-end message flow, resulting in full understanding and 
containment of the fault across all relevant network elements and network layers. 

The ticket pane is displayed beneath the tree pane and workspace in the Cisco ANA NetworkVision 
window. The ticket pane can be displayed or hidden by clicking the arrows displayed below the tree pane. 
For the definition of a ticket, alarm and event, see Events, Tickets and Alarm Definitions, page 1-3.

For more information about tickets, refer to the Cisco Active Network Abstraction EventVision User 
Guide.

A network event is a discrete occurrence or happening in the network at a specific point in time. Events 
are determined from incoming traps, syslogs and detected device changes. A system event is an 
occurrence or happening, usually significant to the performance of a function, operation or task in the 
Cisco ANA system. Examples of events include port status change; device reset or reloads of a 
Cisco ANA VNE. Cisco ANA EventVision enables you to view the event history. For more information, 
refer to the Cisco Active Network Abstraction EventVision User Guide.

Tickets represent an entire lifecycle within the system and include a chain of related events and alarms, 
from the time that the alarm is opened (when the change in behavior is first detected) until it is 
acknowledged, resolved and closed. Examples of alarms are link down, device unreachable or module 
out. Some event types are capable of creating tickets. When an event is generated it is correlated to an 
existing event which is correlated to a ticket. If there is no existing ticket then a new ticket is created.

The ticket pane enables you to view and manage tickets as well as pinpoint the source of the ticket. All 
the tickets that are reported by Cisco ANA are stored in Cisco ANA Gateway’s database. 

Cisco ANA identifies the relationship between a root cause alarm and its consequent alarms. It 
automatically correlates the consequent alarms as “children” of the root alarm. The ticket pane displays 
the ticket (namely, the root cause alarm) and the Ticket Properties dialog box enables you to view all 
correlated alarms.

All Links—Displays the complete list of links for the selected context (map, 
aggregation, or sub-aggregation), namely, the list is not filtered and all the 
links are displayed (including external links).

External Links—Displays the links where only one side of the link starts in 
this context (map, aggregation or sub-aggregation) and the other side ends 
somewhere else, namely, is not in the map or is outside the currently selected 
context.

Flat Links (Surface)—Displays the links currently visible on the map for the 
selected context (map, aggregation or sub-aggregation), excluding, any 
thumbnails.

Deep Links—Displays the links for the current aggregations and the 
sub-aggregations where both of the endpoints are somewhere within the 
currently selected context.
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Note The root cause alarm severity is the topmost severity of its contained alarms.

The ticket pane enables you to perform the following functions:

• View all the tickets or only the filtered tickets of a selected device. For more information about 
filtering tickets, see Filtering Tickets by Device, page 8-4.

• View and filter all the tickets according to specified criteria 
see Filtering Tickets by Criteria, page 8-4.

• View and acknowledge tickets.

• View the properties of a ticket, including the history, correlated alarms, and affected parties.

• Clear a ticket.

• Remove a ticket.

• Clear and remove a ticket.

• Locate the source of a ticket in the map.

• Sort the tickets displayed.

The following columns are displayed in the ticket pane:

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm. This 
indicates the impact of the alarm on the network, namely, one of the following:

– Red—Critical.

– Orange—Major.

– Yellow—Minor.

– Sky Blue—Warning.

– Green—Cleared/Normal/OK.

– Dark Blue—Information.

Note The Information severity does not affect the severity (color) of the network object.

– White—Indeterminate.

For more information about severity, see Map Pane, page 2-7.

• Ticket ID—The sequential ID number of the ticket.

• Short Description—The supported ticket name. 

Note Rule-based alarms can be configured per customer site or upon request.

• Location—The entity that triggered the ticket, as a hyperlink that opens the relevant location.

• Last Modification Time—The date and time when the ticket was last modified. The ticket is 
modified when a user acknowledges the ticket or when an event is correlated.

• Time—The date and time when the initial ticket occurred.

• Acknowledged—The status of the ticket that is being handled, namely, acknowledged (true) or 
unacknowledged (false).
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• Affected Devices—The number of devices affected by the ticket (the source(s) of the alarm and their 
subsequent alarms).

• Correlation Count—Displays the number of correlated alarms included in the ticket. For example, 
if in the Correlation tab of the Ticket Properties window, there are 3 alarms correlated to the root 
cause alarm, then the counter displays the number 3. If there are 2 alarms correlated to the root cause 
alarm, and each alarm in turn has 2 alarms correlated to it, then the counter displays the number 4.

• Reduction Count—Displays the number of alarms included in the ticket. For example, nine alarms 
can be viewed in the History tab of the Ticket Properties window, but only a single ticket is displayed 
in the ticket pane.

• Duplication Count—Displays the number of occurrences of the original root cause alarm included 
in the ticket. For example, if the ticket was created by a link down root cause alarm, and then the 
link goes up and down again quickly so that it is included in the same ticket, then the duplication 
counter displays the number 2, as the root cause alarm occurred twice.

The ticket details in the ticket pane change constantly as they are updated with new information. For 
example, Port Down is updated to Port Up.

The tickets in the ticket pane are by default sorted according to Ticket ID. For information about tickets, 
see Chapter 8, “Working with Tickets”.

The Location field displays the number of selected rows and the total number of rows in the table, for 
example, 2/16 Selected. In addition, it displays the location of the selected row(s) in the table, for 
example, Line 3.

The Find field enables you to search for information in the ticket pane table according to the selected 
column. For more information about the buttons displayed in Cisco ANA NetworkVision’s tables and 
table functionality, see Working with Tables, page 3-1.

For more information about how the status of a network device is displayed in the ticket pane, see Status 
of Network Objects, page 2-15.

Status of Network Objects
The status of a network object is displayed in Cisco ANA NetworkVision in the following ways:

• Severity

• Management State

• Tickets

Severity

Severity indicates the “operational health” of the network device. At any give time an icon has only one 
severity value and this value is displayed using the severity colors. For more information about the colors 
used to display the severity (or propagated severity) of network devices and links, see Map Pane, 
page 2-7.

Propagation

Severity is propagated upwards in the network hierarchy, displaying the topmost severity of its children 
and so ensuring that every single problem in the network is propagated and visible.
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The same severity propagation rules that are used for network elements, apply to links. A link is a child 
object of an aggregation if and only if it is fully contained in the aggregation; namely, the network 
elements on both sides of the link are part of the aggregation, as displayed in the examples below.

Figure 2-3 Link Severity Example 1

In the example above there is a critical link (#1) between two NEs in an aggregation. This will affect the 
severity of the aggregation (#2), namely, the aggregation will be critical because it contains a link with 
a critical severity. Link severity affects the context.

Figure 2-4 Link Severity Example 2

In the example above there is one critical link (#1) that forms part of an aggregated link. This will affect 
the severity of the aggregated link (#2), because it contains a link with a critical severity.

New Ticket Propagation

A new ticket indicates a new local fault or accumulates and propagates the number of new faults in its 
children. New tickets are propagated upwards, displaying the number of new tickets and the topmost 
severity.

When new tickets are accumulated, a label is displayed in the tree pane and map pane, based on the 
following formula:

<n> <s> [+]

The color of the bell displays the topmost severity level(s).

1 2

18
01

11

1 2

18
01

12

Where:

n = Displays the number of tickets with the highest severity in the new ticket count.

s = Displays the highest severity level in the new tickets:

• C = critical

• M = major

• m = minor

• W = warning

• N = normal (cleared alarm)

+ = Indicates that additional, less severe tickets (optional) exist
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Examples:

• An object with three critical new alarms, two major alarms and one warning alarm is labeled 3C+.

• An object with five minor new alarms is labeled 5m.

Management State

The management state indicates the state/mode of the software component (a VNE) managing a network 
device and the communication with it. This enables you to determine the accuracy of the network 
information and the availability of the Cisco ANA VNEs in order to carry out network operations. 

Management states are always local indications and are not propagated. A partial exception to this rule 
is the propagation of unreachable network elements. 

The management state indication only applies to network elements and network element components. A 
network object can only have one state, for example, unsupported or initializing.

A network device icon consists of two components, a device icon and an overlay icon that reflects the 
status, namely, the severity, management state or new alarm. 

The device icon displays a symbol of the network device and the color of the symbol displays the severity 
(or propagated severity) of the network device. For more information about device icons, see Device 
Icons, page A-1. For more information about severity colors, see Map Pane, page 2-7.

A small overlay icon is displayed on top of the device icon to indicate the management state in the tree 
pane and map pane. For example, a Router that Cisco ANA failed to access (unreachable) is displayed 
as illustrated below: 

Figure 2-5 Device with Overlay Icons

Cisco ANA NetworkVision supports the following management states:

1 Alarm icon

2 Device icon

3 VNE Management State icon

1

2

3 18
01

57

Table 2-4 Management States

Priority Value Description Tree Pane Map Pane

Unsupported The VNE does not support the network object 
hardware or software version or a device module.

Initializing The VNE or VNE component is in startup mode or 
is temporarily non-operational.

VNE 
Unreachable

Cisco ANA Gateway received no response from 
the VNE.
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More than one management state can occur at the same time. In this case, a single overlay icon is 
displayed reflecting the device status based on the following priorities: Unsupported > Initializing > 
VNE Unreachable > Device Unreachable > Partially Supported > Operational.

Tickets

A bell icon is displayed in the tree pane, map pane and ticket pane to indicate tickets. Every alarm is 
assigned a severity level, representing the impact of the fault on the network device. The bell icon 
displays the severity level of the topmost alarm. An example is displayed below.

Cisco ANA NetworkVision Toolbar
The Cisco ANA NetworkVision toolbar is context-sensitive and the options vary depending on your 
selection in the application. 

Note The functionality (available on the toolbar and menus) that is accessible to the user depends on the 
permissions defined for the user.

Device 
Unreachable

Cisco ANA failed to access the device.

Partially 
Supported

The group of devices is supported in general, but 
the specific device is only partially supported.

Maintenance The VNE state was manually changed to 
maintenance or when adaptive polling is 
implemented (CPU usage is high), so the VNE is 
no longer polled and the VNE automatically 
moves to maintenance mode (for more 
information, refer to the Cisco Active Network 
Abstraction Administrator Guide. The NE is 
working (status Up), but if there are any alarms or 
tickets that are generated on the device they will 
not be sent to the application.

 

Unknown The device (ghost) type is unknown.

Operational Fully functional. NE icon NE icon

Table 2-4 Management States (continued)

Priority Value Description Tree Pane Map Pane

Value Tree Pane Map Pane

Ticket
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The Cisco ANA NetworkVision window contains the following tools:

Table 2-5 Cisco ANA NetworkVision Toolbar

Button Function

Creates a new map in the database.

Opens a file/map saved in the database using the Open dialog box.

Saves the current map, for example, the background and the location of 
devices, to the database.

Adds a device to the map or to the sub-network selected in the tree pane and 
displayed in the map pane.

Adds a VPN (that has not yet been loaded) to the currently displayed map. For 
more information, refer to the Cisco Active Network Abstraction Managing 
MPLS User Guide.

Opens the Inventory window enabling you to view the physical and logical 
inventory of a device.

Aggregates the devices selected in the map pane of the Cisco ANA 
NetworkVision window and enables you to define a name for the aggregated 
device. 

Opens the Map Options dialog box, enabling the network administrator to 
display or hide different types of links on the map and in the links view.

Defines the size of a selected device(s) or aggregated nodes in the map pane, 
according to predefined sizes or according to a percentage of the current size.

Choose and display an overlay of a specific VPN on top of the devices 
displayed in the network map of the map pane using the Choose Overlay dialog 
box.

When a VPN in the network is selected all the devices and links that are part 
of the VPN are colored and those that are not part of the VPN are grayed out. 
The ones that remain highlighted are the provider edge routers and the physical 
links that carry the LSP that is being used by the VPN. For more information, 
refer to the Cisco Active Network Abstraction Managing MPLS User Guide.

After a selection is made by clicking Choose Overlay, displays or hides a 
previously defined overlay of a specific VPN on top of the physical devices 
displayed in the network map of the map pane.

For more information, refer to the Cisco Active Network Abstraction Managing 
MPLS User Guide.

Opens the Find Business Tag dialog box, enabling the network administrator 
to find and/or delete a business tag according to a name, key or type.

Moves up a branch in the tree pane and map pane in order to view different 
information.

Finds a device or aggregated node in the network/map according to the name.
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Menu Bar
This section provides a description of each option available in the Cisco ANA NetworkVision menus. 
The following menus are available:

• File Menu

• Edit Menu

• View Menu

• Node Menu

• Tools Menu

• Window Menu

• Help Menu

Note Based on the security level and access permissions assigned to a user, some of the menu options may not 
be available. 

Note The menus are context-sensitive and the options vary depending on your selection in the application.

Defines the way in which the map lays out the NEs in the map pane of the 
Cisco ANA NetworkVision window, namely, Circular, Symmetric, tree or 
Hierarchical.

Displays the device view in the Cisco ANA NetworkVision window (the button 
toggles when selected or deselected).

Displays the links view in the Cisco ANA NetworkVision window (the button 
toggles when selected or deselected).

Displays the map pane in the Cisco ANA NetworkVision window (the button 
toggles when selected or deselected).

Opens a window displaying an overview of the network.

Activates the normal selection mode (the button toggles when selected or 
deselected).

Activates the pan mode, which enables you to move around in the map pane by 
clicking and dragging (the button toggles when selected or deselected).

Activates the zoom selection mode, which enables you to select an area in the 
map pane to be enlarged by clicking and dragging to view the selected area (the 
button toggles when selected or deselected).

Fits the entire sub-network/map in the map pane.

Table 2-5 Cisco ANA NetworkVision Toolbar (continued)

Button Function
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File Menu

The File menu displays the following options (for more information see Chapter 4, “Working with 
Cisco ANA NetworkVision Maps”):

New Map

Creates a new map in the database.

Open

Opens a file/map saved in the database using the Open dialog box.

Close Map

Closes the map currently displayed in the Cisco ANA NetworkVision window.

Load Path Tracer

Loads a Cisco ANA PathTracer map from a previously saved file in the Cisco ANA PathTracer 
Multi-Path window.

Add Device

Opens the device view and enables you to add a device to the map or to the sub-network selected in the 
tree pane and displayed in the map pane. This option is enabled when a map is open and you have the 
relevant security level, namely, OperatorPlus.

Add VPN

Adds a VPN (that has not yet been loaded) to the currently displayed map. For more information, refer 
to the Cisco Active Network Abstraction Managing MPLS User Guide.

Note When you create a VPN or load a VPN Service View map, you may add and configure tunnels using a 
shortcut menu. For more information, refer to the Cisco Active Network Abstraction Managing MPLS 
User Guide.

Save Map

Saves the appearance of the map, for example, the background and the location of devices, to the 
database. This option is enabled when a map is open and you have the relevant security level, namely, 
OperatorPlus.

Save As Image

Saves the active map as an image and automatically displays the Save as Image dialog box. Use this 
dialog box to save an image using a different file format or name. 

Print Preview

Displays each map, as it will look when printed. 
2-21
Cisco Active Network Abstraction NetworkVision User Guide, Version 3.6

OL-12500-01



 

Chapter 2      Getting Started
    Cisco ANA NetworkVision Window
Print

Prints the active map as displayed in the Print Preview dialog box. 

Exit

Exits the Cisco ANA NetworkVision application and saves the workspace.

Edit Menu

The Edit menu displays the following options:

Find in Map

Searches for a device in the network/map that contains the specified text in the name or the IP fields.

Find Business Tag

Searches for business tag information in the database.

Resize

Displays the Resize dialog box, enabling you to define the percentage used to resize device icon(s) or 
aggregated nodes in the map pane.

Note The Resize option is only available when a device icon(s) or aggregated nodes are selected.

View Menu

The View menu displays the following options:

Layout

Defines the way in which the map is displayed in the map pane of the Cisco ANA NetworkVision 
window’s workspace, namely, Circular, Symmetric, Tree or Hierarchical. 

Overview

Opens a window displaying an overview of the network map.

Zoom In

Zooms in on the network map. 

Zoom Out

Zooms out of the network map. 

Fit In Window

Displays the entire network map in the map pane. 
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Normal Select

Activates the normal selection mode. The selected option is grayed out.

Pan

Activates the pan mode, which enables you to move around in the map pane by clicking and dragging. 
The selected option is grayed out.

Zoom Selection

Activates the zoom selection mode, which enables you to select an area in the map pane to be enlarged 
by clicking and dragging to view the selected area. The selected option is grayed out.

Node Menu

The Node menu displays the following options:

Note Most of the functionality available in this menu is only available when a device icon or an aggregated 
node is selected in the tree or map pane.

Inventory

Displays a dialog box enabling you to view the physical and logical inventory. For physical inventory 
you can view all the components of the device, for example, modules and ports. In addition, you can 
view the status of each component. For logical inventory you can view all the profiles and VC or routing 
tables of the device. For more information see Chapter 6, “Viewing Network Device Inventory”.

Aggregate

Groups the selected devices into an aggregation in the map pane of the Cisco ANA NetworkVision 
window’s workspace and enables you to define a name for the aggregated node. For more information 
see Chapter 4, “Working with Cisco ANA NetworkVision Maps”. 

Disaggregate

Ungroup the selected aggregated node in the tree pane and map pane of the Cisco ANA NetworkVision 
window. All the nodes in the selected aggregation move up one level and the selected aggregation is 
removed. For more information see Chapter 4, “Working with Cisco ANA NetworkVision Maps”.

Note Only available when an aggregated node is selected in the tree or map pane.

Mark as A Side

Starts the process of creating a new static link. This option is enabled when a device, port or unmanaged 
network is selected.
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Mark as Z Side

Launches the Add Static Link dialog box, enabling you to create a static link between to the two selected 
nodes. This option is enabled after a device, port or unmanaged network is selected and after the Mark 
as A Side option is selected.

Note When the user selects two ports, the Add Static Link dialog box is not displayed.

Properties

Displays a dialog box enabling you to view the properties of the selected device, for example, the 
severity, IP address and communication state. For more information see Chapter 5, “Viewing Device 
Properties”.

Tools Menu

The Tools menu displays the following options:

Change User Password

Enables you to change the password used when logging in to the Cisco ANA Client application suite. 
The change will take effect the next time that the user logs in to the application.

Note The administrator can also change your password in Cisco ANA Manage. 

Options

Enables you to customize several of Cisco ANA NetworkVision’s options, for example, load workspace 
on startup. For more information
see Selecting Cisco ANA NetworkVision Map and Alarm Options, page 2-31.

Window Menu

The Window menu displays the names of all the maps open in the Cisco ANA NetworkVision window’s 
workspace enabling you to move between the maps. 

Help Menu

The Help menu provides the user with information about Cisco ANA NetworkVision and provides 
access to the Help.

Cisco ANA NetworkVision Help

Opens the Cisco ANA NetworkVision online Help.

Cisco.com

This option is currently unavailable in this version.
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About Cisco ANA NetworkVision

Displays application information about Cisco ANA NetworkVision, for example, the version number.

Shortcut Menus
Right-clicking in a specific area or on a link, device or alarm in the Cisco ANA NetworkVision window 
opens the following shortcut menus:

• Device Shortcut Menu

• Map Shortcut Menu

• Aggregated Node Shortcut Menu

• Link Shortcut Menu

• Links View Shortcut Menu

• Ticket Shortcut Menu

A shortcut menu is displayed when you right-click in many of Cisco ANA NetworkVision’s dialog boxes 
or tables. For example, you can open a map from the Map List dialog box using the shortcut menu. The 
options displayed vary depending on the dialog box or tables currently displayed and the selection. For 
more information about any of the shortcut menu options displayed, refer to the options discussed in this 
section.

Note • Based on the security level and access permissions assigned to a user, some of the menu options may 
not be available. 

• The menus are context-sensitive and the options vary depending on your selection in the application, 
for example, the shortcut menus for NEs and aggregated nodes are different.

Device Shortcut Menu

The Device shortcut menu is displayed when you right-click a device in the tree pane, and workspace.

Note The Device shortcut menu is context-sensitive and the options vary depending on your selection in the 
application. Some options may not be available when multiple devices are selected.

Inventory

Displays a window enabling you to view the physical and logical inventory. For physical inventory, you 
can view all the components of the device, for example, modules, ports, and its IP address or configured 
VLANs. In addition, you can view the status of each component. For logical inventory, you can view all 
the profiles and VC tables of the device. For more information see Chapter 6, “Viewing Network Device 
Inventory”.

Aggregate

Aggregates the devices selected in the map pane of the Cisco ANA NetworkVision window and enables 
you to define a name for the aggregated device. For more information see Chapter 4, “Working with 
Cisco ANA NetworkVision Maps”.
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Disaggregate

Ungroup the selected aggregated node(s) in the tree pane and map pane of the Cisco ANA 
NetworkVision window. For more information see Chapter 4, “Working with Cisco ANA 
NetworkVision Maps”.

Note Only available when an aggregated node is selected in the tree or map pane.

Attach Business Tag

Attaches a business tag to the selected network element. For more information see Chapter 10, “Working 
with Business Tags”.

Detach/Edit

You can detach or edit a business tag from the selected Network Object. For more information see 
Chapter 10, “Working with Business Tags”.

Note The Detach and Edit options are only displayed when a business tag is attached to a Network Object.

Filter Tickets

Filters the tickets shown in the ticket pane so that it only displays the tickets of a selected device/network 
element.

Resize

Displays the Resize dialog box that enables you to define the percentage used to resize the device icon(s) 
or aggregated nodes in the map pane.

Remove from Map

Removes the selected device and all its children from the map (tree pane and workspace). The device 
that has been removed is still maintained in the network.

Save as new map

Creates a new map and places the selected aggregation as the root, while leaving the original map intact.

Tools

The Tools option contains the following sub-menu options:

• CPU Usage—Displays memory and CPU usage information for a device/network element.

• Ping—Pings the device from the client station.

• Telnet—Communicates with the device using the Telnet window from the client station.
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Topology

The Topology option enables you to:

• Add a new static link between two devices.

• Add new static topology between a device and an unmanaged network.

It contains the following sub-menu options in order to define the A Side and Z Side of the link:

• Mark as A Side

• Mark as Z Side

When working with VPNs in VPN Service View, the Topology sub-menu allows you define and 
configure tunnels. For more information, refer to the Cisco Active Network Abstraction Managing MPLS 
User Guide.

Properties

Displays the properties of the selected device, for example, IP address and system name. In addition, you 
can open the VNE Properties dialog box and manage VNE properties. For more information see 
Chapter 6, “Viewing Network Device Inventory”.

VNE Tools

Changes the status of the VNE by starting or stopping the VNE. For more information see Chapter 5, 
“Viewing Device Properties”.

Management

It contains the following sub-menu options:

• Command Builder—Defines commands and scripts using the Cisco ANA Command Builder tool 
(Configurator security level required). For further information, refer to the Cisco Active Network 
Abstraction Command Builder User Guide.

• Soft Properties Management—Extend VNEs by adding SNMP MIB and/or Telnet/SHH/TL1 
properties to the device’s collected information model using the Cisco Extended Properties Manager 
wizard (Administrator security level required). For further information, refer to the Cisco Active 
Network Abstraction Customization User Guide. 

Map Shortcut Menu

The Map shortcut menu is displayed when you right-click anywhere on a map in the map pane. 

Go to Parent

Goes to the parent in the tree pane and map pane in order to view different information.

Go to Root

Goes to the root in the tree pane and map pane in order to view different information.
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Aggregate

Creates an aggregation of the selected nodes in the tree pane and map pane of the Cisco ANA 
NetworkVision window and enables you to define a name for the aggregation. For more information see 
Chapter 4, “Working with Cisco ANA NetworkVision Maps”.

Filter Tickets

Filters the tickets shown in the ticket pane so that it only displays the tickets of a selected device/network 
element.

Aggregated Node Shortcut Menu

The Aggregated Node shortcut menu is displayed when you right-click on an aggregated node in the map 
pane.

Aggregate

Aggregates the devices selected in the map pane of the Cisco ANA NetworkVision window and enables 
you to define a name for the aggregated device. For more information see Chapter 4, “Working with 
Cisco ANA NetworkVision Maps”.

Disaggregate

Ungroup the selected aggregated node in the tree pane and map pane of the Cisco ANA NetworkVision 
window. For more information see Chapter 4, “Working with Cisco ANA NetworkVision Maps”.

Note Only available when an aggregated node is selected in the tree or map pane.

Filter Tickets

Filters the tickets shown in the ticket pane so that it only displays the tickets of the selected aggregated 
node.

Rename

Renames the selected aggregated node.

Resize

Defines the size of selected devices or aggregated nodes in the map pane according to predefined sizes 
or according to a percentage of the current size.

Remove from Map

Removes the selected aggregated node and all its children from the map (tree pane and map pane). 

Save as New map

Creates a new map and places the selected aggregation as the root, while leaving the original map intact.
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Show Thumbnail

Displays a thumbnail of the selected aggregated node in the map pane, including all the aggregated 
devices.

Show as Aggregation

Displays the aggregated node in the map pane.

Note The Show as Aggregation option is displayed in the shortcut menu when a thumbnail is displayed in the 
map pane.

Link Shortcut Menu

The Link shortcut menu is displayed when you right-click a link in the map pane. For more information 
see Chapter 7, “Working with Links”.

Filter Tickets

Filters the tickets shown in the ticket pane so that it only displays the tickets of a selected Network 
Object.

Properties

Displays the properties of the selected link.

Links View Shortcut Menu

The Links View shortcut menu is displayed when you right-click a link in the links view table displayed 
in the Cisco ANA NetworkVision window’s workspace. For more information see Chapter 7, “Working 
with Links”.

Attach Business Tag

Attaches a business tag to the selected link. For more information see Chapter 10, “Working with 
Business Tags”.

Detach/Edit

You can detach or edit a business tag from the selected link. For more information see Chapter 10, 
“Working with Business Tags”.

Note The Detach and Edit options are only displayed when a business tag is attached to a link.

Find Source

Finds the link source, if it exists, by highlighting the link in the map pane.
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Properties

Displays the properties of the selected link.

Ticket Shortcut Menu

The Ticket menu is displayed when you right-click the ticket in the ticket pane. The Ticket menu enables 
the network administrator to view ticket properties and to highlight a device that is the source of a ticket. 
The Ticket menu also enables you to acknowledge, clear and remove a ticket. For more information see 
Chapter 8, “Working with Tickets”.

Acknowledge

Acknowledges that the ticket is being handled and the ticket is displayed as true in the ticket pane. 
Acknowledging an alarm removes the alarm icon from the device icon.

Note Multiple tickets can be acknowledged at the same time.

Clear

Approves the reported faulty ticket and clears the faulty networking entity from Cisco ANA. The ticket 
is displayed as Clear in the ticket pane.

Note When a Card Out or Link Down alarm occurs the relevant information is displayed in the inventory and 
maintained in the VNE.

Remove

Removes the ticket and all its active sub-tickets from the ticket pane (this option is only available after 
the ticket has been cleared). The deleted tickets can be viewed using Cisco ANA EventVision.

Note • Multiple tickets can be removed at the same time.

• When a ticket is removed the information is no longer displayed in the inventory and is removed 
from the VNE.

Clear and Remove

Approves the reported faulty ticket and clears the faulty networking entity from Cisco ANA. In addition, 
the ticket, and all its active sub-tickets are removed from the ticket pane.

Find Source

Finds the ticket source, if it exists, by highlighting the device or link in the map pane.

Properties

Displays the Ticket Properties dialog box enabling you to view ticket information, including impact 
analysis details of the affected parties and correlated alarms.
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Changing a User Password
Cisco ANA NetworkVision enables the user to change his/her login password.

Note The administrator can also change the user password in Cisco ANA Manage.

Note Cisco ANA NetworkVision has the following pre-configured password defaults; the administrator can 
however modify these defaults using the Cisco ANA Registry:

• The minimum length of the user password is 6 characters.

• The maximum length of the user password is 10 characters.

• The minimum number of digits that must be included in the user password is 1.

To change a user password:

Step 1 Select Change User Password from the Tools menu. The Change User Password dialog box is 
displayed.

The following fields are displayed in the Change User Password dialog box:

• Old password—Enter the old user password.

• New password—Enter the new user password.

• Confirm password—Enter the new user password again to confirm the new password.

Step 2 Click OK. The change will take effect the next time that you log in to the application.

Note Clicking Show Password Rules in the Change User Password dialog box, displays the password 
rules.

Selecting Cisco ANA NetworkVision Map and Alarm Options
Cisco ANA NetworkVision enables you to customize the startup and display options.

To customize Cisco ANA NetworkVision:

Step 1 Select Options from the Tools menu. The Options dialog box is displayed.

The following checkbox is displayed in the Workspace Info area:

• Load Workspace On Startup—Your workspace is automatically loaded when logging in.

The Display tab enables you to define the display options for the application, for example, whether 
business tags are displayed. The Display tab is shown below.

The following checkboxes are displayed in the Severity area:
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• Show Severity Text—Displays severity labels in the tree pane and map pane, as per the formula 
described in New Ticket Propagation, page 2-16.

• Show Acknowledged—Displays a critical alarm severity even after the alarm is acknowledged.

• Show Propagated—Displays only the alarms on the specific entity, namely, it does not display 
propagated alarms.

The following radio buttons are displayed in the Display Name area:

• Do not use Business Tag—Select this option to display the original network element name only.

• Add Business Tag to name—Select this option to display the original network element name and 
the name of the business tag.

• Replace name with Business Tag—Select this option to replace the network element name with the 
name of the business tag. When a subscriber is attached to a port the name of the subscriber is also 
added.

The Audio tab enables you to define whether sounds are used when an alarm is triggered and what these 
sounds will be. 

You can select whether or not sound alarms are enabled, by selecting the Enable Audio Response for 
Alarm checkbox is displayed at the top of the Audio tab.

Selecting the Enable Audio Response for Alarm option enables the chosen sound files to be played when 
an alarm is triggered. You can select different sound files for critical, major, and minor alarms. 

The following fields are displayed in the Alarm area:

• Critical—Enables you to define and test the .wav file that is used to alert the user when a critical 
alarm is triggered.

• Major—Enables you to define and test the .wav file that is used to alert the user when a major alarm 
is triggered.

• Minor—Enables you to define and test the .wav file that is used to alert the user when a minor alarm 
is triggered.

The following checkbox is displayed in the Alarm area:

• Loop Sound on Critical Alarm—Defines whether the critical alarm sound is played once only or 
is continuous, namely, loops.

Step 2 Define the options that you require.

Step 3 Click OK/Apply to save your changes. The changes will take affect when the application is restarted.

Logging Out 
When you have finished working with Cisco ANA NetworkVision you can log out of the application. 
Any open maps and the workspace are automatically saved when you log out.

To log out of Cisco ANA NetworkVision:

Step 1 From the File menu, select Exit or click in the right-hand top corner of the Cisco ANA NetworkVision 
window. A confirmation message is displayed.

Step 2 Click Yes. The Cisco ANA NetworkVision window is closed.
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Note If the map appearance has changed a message is displayed asking you whether to save the current 
appearance of the map(s).
2-33
Cisco Active Network Abstraction NetworkVision User Guide, Version 3.6

OL-12500-01



 

Chapter 2      Getting Started
    Logging Out
2-34
Cisco Active Network Abstraction NetworkVision User Guide, Version 3.6

OL-12500-01



 

Cisco Active Network
OL-12500-01
C H A P T E R 3

Working with Cisco ANA NetworkVision Tables

This chapter describes how to work with Cisco ANA NetworkVision’s tables and how to perform general 
Cisco ANA NetworkVision functions, for example, printing, filtering and saving a map image.

• Working with Tables, page 3-1, describes how to work with the Cisco ANA NetworkVision tables, 
including finding text, defining filters and exporting the table.

• Setting Selection Filters, page 3-3, describes how to define a selection filter in a table.

• Sorting a Table, page 3-4, describes how to sort a table by defining specific criterion.

• Exporting the Table to a File, page 3-5, describes how to export all the currently displayed data from 
the Cisco ANA NetworkVision table.

Working with Tables
Various tables are used throughout the application to display different types of information. Some of the 
functionality provided in the Cisco ANA NetworkVision tables is described below:

• Find text in a table. For more information see Finding Text in a Table, page 3-2.

• Define and remove a filter in a table. For more information see Defining a Filter, page 3-2 and 
Clearing a Filter, page 3-3.

• Set a selection filter and/or view a previous selection filter. For more information see Setting 
Selection Filters, page 3-3.

• Export table information. For more information see Exporting the Table to a File, page 3-5.

• Sort the table according to a column. For more information see Sorting a Table, page 3-4.

For more information about the toolbar displayed in the workspace, see Device View, page 2-9.

Cisco ANA NetworkVision enables the user to sort a table in one or more of the following ways:

• According to a column by clicking on the required column heading. The  icon is displayed next 
to the selected column heading indicating continuous sorting.

• In ascending or descending order by clicking on the column heading.

• By clicking the Sort Table Values button on the toolbar of the table and specifying the criterion by 
which the table will be sorted. For more information about sorting a table using the Sort Table Values 
button, see Sorting a Table, page 3-4.

A triangle is displayed next to the column heading to indicate the column according to which the table 
is sorted.
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The user can open the Filter dialog box by clicking the Filter button and sorting criteria by table field, 
operator, and text. 

Clicking on a red triangle automatically expands the cell to view all the data.

Finding Text in a Table
Cisco ANA NetworkVision enables you to search for information about a specific network object in a 
table by entering the search criteria, for example, by entering a partial IP address.

The table below lists the keyboard shortcuts that can be used when working with tables:

To find text in a table:

Step 1 In the Find field on the toolbar, enter the search criteria for the entity that you want to find.

Step 2 Press Enter. The row matching the search criteria is highlighted in the table.

Note Click F3 to continue searching the table.

Note Use Ctrl + F to jump to find.

Defining a Filter
Cisco ANA NetworkVision enables you to define a filter for the data displayed in a Cisco ANA 
NetworkVision table by selecting filter criteria. 

This tool occurs throughout the application with the same functionality. The ticket pane has its own 
unique filter. For more information see Filtering Tickets by Criteria, page 8-4.

Keyboard Shortcut Description

Ctrl + A Select all the rows in the table.

Ctrl + Space Deselect all the rows in the table.

Enter On a selected row opens the default action.

Arrow Navigation Keys Navigates up and down in the rows.

Ctrl + Up/Down Keeps the selected row and moves up/down.

Ctrl + Up/Down + Space Keeps the selected row and moves up/down. The space selects 
the required row.

Shift + Up/Down Keeps the selected row and selects all the rows that are 
up/down.

Shift + F10 Opens the shortcut menu.

F3 Finds next.

Shift F3 Finds previous.
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To define a filter:

Step 1 On the toolbar, click Filter. The Filter dialog box is displayed.

The following dropdown lists are displayed in the Filter dialog box:

• Field—A dropdown list of all the columns displayed in the table.

• Operator—A dropdown list of the values included in the filter operation. The Not checkbox 
indicates that the selected value should not be included in the filter. For example, if you select 
Contains this means that the value should not be contained in the filter.

The following field is also displayed:

• Search for—Enter the required filter value or select the required value from the Field and Operator 
dropdown lists.

Step 2 Select an option from the Field and Operator dropdown lists.

Step 3 Enter the required filter values or select the required value from the dropdown list in the Search for field.

Step 4 Click OK. The table data is displayed using the defined filter. 

Note The Filter button toggles to indicate that a filter has been applied.

The filter can be cleared in order to redisplay all the data in the table.

Clearing a Filter
Cisco ANA NetworkVision enables you to clear a filter that was defined for the data displayed in a 
Cisco ANA NetworkVision table. 

To clear a filter:

Step 1 On the toolbar, click Filter. The Filter dialog box is displayed.

Step 2 Click Clear. The table is redisplayed with all the data in the Cisco ANA NetworkVision window’s 
workspace.

Setting Selection Filters
The user can choose a line or specific set of lines, and display them in the table (all un-selected lines are 
hidden). The user may make continuous multiple line selections, setting the table content after each 
selection, using the Set Selection Filter button.

The user can undo the last selections (one step back), one at a time, using the Previous Selection Filter 
button, or undo (rewind) all selections, using the Rewind All dropdown menu option. 

This powerful Cisco ANA filtering mechanism enables the user sort though several hundred lines and 
pinpoint the appropriate line(s) that contain the required information.
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For example, to filter and display seven lines in a 129 line Database Segment table, you:

• Select the appropriate lines in the table using standard Windows mouse and/or keystroke operations

• Apply the filter to the selected line(s) using the Set Selection Filter button.

To choose multiple lines and apply the set a selection filter:

Step 1 Select the line(s) in the table using the mouse and standard Microsoft® Windows selection keys. The Set 
Selection Filter button is activated.

Step 2 Click the Set Selection Filter button. Only the selected line(s) remain in the table.

The user can undo the last line selections (one step back), one at a time, using the Previous Selection 
Filter button.

To undo the previous filter selection:

Step 1 Select one or several lines and filter them out using the Set Selection Filter button.

Step 2 To undo the last filtering out selection, select the Previous Selection Filter button. The table will display 
all lines that appeared before your last filter selection.

The user can undo (rewind) all multiple line selections, using the Rewind All dropdown menu option.

To undo all previous selected filter out options:

Step 1 Select, filter out and sort lines as required in the table using the Set Selection Filter button.

Step 2 Click the Previous Selection Filter button. The Rewind All dropdown menu option is displayed.

Step 3 Select Rewind All. All the lines in the table are displayed.

Note To clear all manually selected and defined filter options, use the Clear command button in the 
Filter dialog box (see Clearing a Filter, page 3-3 for more information about clearing filters).

Sorting a Table
The tables displayed in Cisco ANA Manage can be sorted by defining specific criterion on a one-time 
only basis or continuously.

To sort a table:

Step 1 On the toolbar, click Sort Table Values. The Sort dialog box is displayed. 

The following dropdown lists are displayed in the Sort By area:

• Sort By—A dropdown list of all the columns displayed in the currently displayed table. The table 
is sorted firstly according to the selection made here. Select ascending or descending order.
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• Then By—Dropdown lists of all the columns displayed in the table. The table is sorted secondly and 
then lastly according to the selections made here. Select ascending or descending order.

The following radio buttons are displayed in the Sort Operation area:

• Once Only—Sorts the information displayed in the table according to the specified criterion once 
only. When this option is selected a triangle  is displayed in the table heading for the selected 
column.

• Continuously/Repeatedly—Sorts the information displayed in the table according to the specified 
criterion continuously. When this option is selected the  icon is displayed next to the selected 
column heading.

Step 2 Select an option from the Sort By dropdown list and Ascending or Descending order.

Step 3 Select an option from the Then By dropdown lists and Ascending or Descending order (optional).

Step 4 Select Once Only or Continuously/Repeatedly.

Step 5 Click OK. The table information is sorted according to the filter defined.

Note The Sort By default option depends on the table you are sorting. For example, when you click 
Sort Table Values in the links view table, the default value is Context. The default sorting is 
configured in the registry by type.

Exporting the Table to a File
Cisco ANA NetworkVision enables you to export all the currently displayed data from the Cisco ANA 
NetworkVision table. Either the selected row(s) is exported or when nothing is selected the entire table 
is exported. The data can then be imported and viewed at a later stage. 

Note Press Ctrl + Space to ensure nothing is selected in the table.

To export the table to a file:

Step 1 On the toolbar, click Export to CSV. The Export Table to File dialog box is displayed.

Step 2 Browse to the directory where you want to save the table.

Step 3 In the File name field, enter a name for the table.

Step 4 Click Save. The table or row(s) is saved in the selected directory.
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C H A P T E R 4

Working with Cisco ANA NetworkVision Maps

This chapter describes how to work with the topological maps displayed in the workspace of the 
Cisco ANA NetworkVision window. The topological map is the main tool used by Cisco ANA 
NetworkVision to display the links and relationships between the network elements and/or aggregated 
nodes. 

• Opening Selected Maps, page 4-2, describes how to open maps that were last visited by you, quickly 
and easily when the application is launched.

• Creating a New Map, page 4-3, describes how to create a new map.

• Opening a Map, page 4-4, describes how to open an existing map.

• Adding a Device, page 4-5, describes how to add a device in a map.

• Removing a Device from the Map, page 4-6, describes how to remove a device from the map.

• Defining the Map Layout, page 4-6, describes how to define the layout of the network in a map.

• Saving a Map, page 4-7, describes how to save the layout of the map.

• Saving as a New Map, page 4-8, describes how to save a copy of the entire map or parts thereof while 
leaving the original map intact.

• Saving a Map as an Image, page 4-8, describes how to save a map as an image.

• Closing a Map, page 4-10, describes how to close a map.

• Deleting a Map, page 4-10, describes how to delete a map.

• Renaming a Map, page 4-10, describes how to rename an existing map.

• Resizing a Device, page 4-11, describes how to define the size of selected device(s) or aggregated 
nodes in the map pane.

• Viewing the Network, page 4-12, describes how to display the entire network map or any part of the 
map, in the Overview window. In addition, it describes how to display an aggregated node in a 
thumbnail.

• Viewing a Network Device, page 4-13, describes how to view any network device on the map. The 
device is selected in the appropriate map in the workspace and/or tree pane and the active tickets are 
shown in the ticket pane.

• Selecting Map Views, page 4-14, describes the various selection tools that can be used to view and 
analyze maps in the map pane.

• Finding a Ticket Source, page 4-15, describes how to find the source of a ticket displayed in the 
ticket pane.

• Finding a Link Source, page 4-15, describes how to find the source of a link displayed in the links 
view.
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• Finding a Network Device, page 4-15, describes how to find and display a network device on the 
map.

• Aggregating Devices, page 4-16, describes how to aggregate devices. In addition, it describes how 
to disaggregate the aggregated node selected in the map pane. 

• Renaming an Aggregated Node, page 4-17, describes how to rename an existing aggregated node.

• Filtering Links According To Type, page 4-17, describes how to filter (display or hide) the different 
types of links displayed in the map pane.

• Opening the CPU Usage Graph, page 4-20, describes how to display memory and CPU usage 
information for a device.

• Communicating with Devices, page 4-20, describes how to ping and telnet a device.

• Previewing a Map, page 4-21, describes how to preview a map before it is printed. 

• Defining the Print Setup, page 4-22, describes how to define the print setup. 

• Printing a Map, page 4-23, describes how to print the map that is currently displayed.

Opening Selected Maps 
When Cisco ANA NetworkVision is launched, the Cisco ANA NetworkVision window appears. Maps 
that were last visited by you can be opened quickly when the application is launched, if you closed the 
application without closing the maps.

Note First time users and users that closed their maps before closing the application will not be able to open 
maps using this functionality.

To open a selected map:

Step 1 Launch Cisco ANA NetworkVision. The Cisco ANA NetworkVision window is launched with the Open 
Selected Maps dialog box. For more information about launching Cisco ANA NetworkVision, see 
Starting Cisco ANA NetworkVision, page 2-1.

The Open Selected Maps dialog box displays a list of the maps last visited by you and that were not 
closed by you when exiting the application. By default all the maps that were last visited by you are 
selected.

The following buttons are displayed in the Open Selected Maps dialog box:

• All—Selects and opens all the last visited maps.

• Selected—Opens the maps that have been selected (checked) in the Open Selected Maps dialog box.

• None—Deselects all the last visited maps and displays an empty Cisco ANA NetworkVision 
window. You can now create a new map (see Creating a New Map, page 4-3) or open a map that was 
previously saved in the database.

Step 2 Click All,

or

Click None,

or
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Clear the checkbox(es) for the maps that you do not want to display in the Cisco ANA NetworkVision 
window and click Selected.

The maps are displayed in the Cisco ANA NetworkVision window according to the defined selection.

Note By default you can only view and work on a maximum of five maps at any given time in the 
NetworkVision map pane (to change this default setting please contact Cisco Professional 
Services). To create a new map or select a new map, close the required amount of maps.

Creating a New Map 
When Cisco ANA NetworkVision is launched for the first time, or if None is selected in the Open 
Selected Maps dialog box (as described in the previous section) the Cisco ANA NetworkVision window 
appears empty.

A new map must be created, or a map that was previously saved can be opened, in order to display the 
network. Cisco ANA NetworkVision supports the creation of multiple network maps in order to 
represent specific network views. Views can cover specific network segments, customer networks, or any 
other mix of network elements desired. When a user creates a map it is available to other users (assuming 
they have sufficient access/security privileges).

The network maps provide a graphic display of active faults and alarms and serve as an easy access point 
for the activation of services.

Note You can create a new map, select a filter and then add the devices to the map. This filter will then be 
applied to the new map and only the required link types will be visible in the map pane and recorded the 
links view. For more information see Filtering Links According To Type, page 4-17.

Note You cannot define the same name for two or more maps.

To create a new map:

Step 1 On the toolbar, click New Map, 

or

Select New Map from the File menu. The Create Map dialog box is displayed. 

Note Cisco ANA NetworkVision has the following pre-configured map name defaults; the 
administrator can however modify these defaults using the Cisco ANA Registry:
The minimum map name length of is 1 character.
The maximum map name length is 65 characters.
The map name cannot contain any symbols, excluding the $ symbol.

The Advanced button enables you to filter the links displayed in the map pane. For more information 
see Filtering Links According To Type, page 4-17.
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Step 2 Enter a name for the new map and click OK. An empty new map is displayed in the tree pane and map 
pane, as displayed below. For more information on adding devices, see Adding a Device, page 4-5. 

Opening a Map
Cisco ANA NetworkVision enables you to open a map that was previously saved. When you open the 
map, the network information is automatically refreshed. For example, if a device was up the last time 
that the map was saved and closed, and then the device is moved to maintenance, the next time you open 
the map the management status of the device will be updated accordingly and the device will display a 
maintenance status.

Note The maps that you last visited can be opened quickly when the application is launched provided that you 
closed the application without closing the maps. For more information 
see Opening Selected Maps, page 4-2.

To open a map:

Step 1 On the toolbar, click Open Map,

or

Select Open from the File menu. The Map List dialog box is displayed.

The Map List dialog box displays the map name as defined by the network administrator.

The Find field enables you to search for information in the table according to the selected column. For 
more information see Finding Text in a Table, page 3-2.

The Map List dialog box contains the following tools:

Tool Description

Export to CSV—Exports the information displayed in the table. For more 
information see Exporting the Table to a File, page 3-5.

Note The tools described above occur throughout the application and 
provide the same functionality.

Delete Map—Deletes the selected map from the Map List dialog box, the 
Cisco ANA NetworkVision window and from the database. If a map that is 
being opened is deleted, this map will close. For more information see 
Deleting a Map, page 4-10.

Rename Map—Renames the selected map in the Map List dialog box and 
Cisco ANA NetworkVision window. For more information see Renaming a 
Map, page 4-10.

Sort Table Values—Enables you to sort the information displayed in the 
table.

Filter—Defines a filter for the information displayed in the table. For more 
information see Defining a Filter, page 3-2.

Note When a filter is applied the Set Selection Filter button is activated.
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Step 2 Select the map that you require from the Map List and click Open,

or

Right-click on the required map, and select Open from the displayed shortcut menu,

or

Double-click on the required map. The map is displayed in the Cisco ANA NetworkVision window with 
the network.

One or more maps can be opened in the Cisco ANA NetworkVision window displaying the various 
available networks. Use the Windows menu to move between the open maps. For more information on 
the Cisco ANA NetworkVision window, see Chapter 2, “Getting Started”.

Note By default you can only view and work on a maximum of five maps at any given time in the 
NetworkVision map pane (to change this default setting please contact Cisco Professional Services). To 
create a new map or select a new map, close the required amount of maps.

Adding a Device
Cisco ANA NetworkVision enables you to add devices to the network. The device is added to the map 
or aggregation selected in the tree pane and workspace. In addition, devices that are added to the network 
are automatically saved. 

Note Based on the security level and access permissions assigned to a user, this option may not be available.

To add a device:

Step 1 On the toolbar, click Add Device,

or

Select Add Device from the File menu. The Device List dialog box is displayed, with all the devices that 
are managed by the system.

Set Selection Filter—Applies filters to the selected line or lines displayed in 
the Map List. 

Note When you select one or multiple lines, the Previous Selection Filter 
(and Rewind All) buttons are activated.

Previous Selection Filter—Enables you to undo the last applied filter 
selection. 

Rewind All—Enables you to undo previous filter selections, and display all 
the original information in the table. 

Help—Opens the online help.

Tool Description
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Note Locked devices only display device information and the Locked Device icon.

For more information about:

• The columns that are displayed in the Device List dialog box, see Device View, page 2-9.

• The buttons displayed in the Device List dialog box, see Device View, page 2-9.

Step 2 From the Device List, select the device that you want to add.

Note You can select and add multiple devices using <Ctrl> or <Ctrl +A> or by clicking and dragging 
the mouse.

Step 3 Click Add Device. The device is displayed in the tree pane and the selected map or sub-network in the 
Cisco ANA NetworkVision window’s workspace. In addition, any tickets are displayed in the ticket 
pane.

Note When a device is added to the network it is no longer displayed in the Device List dialog box 
dialog box.

Step 4 Click Close to close the Device List dialog box. The Cisco ANA NetworkVision window is displayed.

Removing a Device from the Map
Cisco ANA NetworkVision enables you to remove a device or aggregated node from the map. 

A device that has been removed from the map is not deleted from the network. 

To remove a device or aggregated node from the map:

Step 1 Select the device or aggregated node that you want to delete in the tree pane or map pane.

Step 2 Right-click to display the shortcut menu and select Remove from Map. The selected device or 
aggregated node is removed from the map.

Defining the Map Layout
Cisco ANA NetworkVision enables you to select the way in which the network object topology is 
displayed. The map pane displays the selected layout, namely, Circular, Symmetric, Hierarchical or 
Tree.
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To define the map layout:

Step 1 On the toolbar, click on the dropdown list next to the Layout button and select one of the following 
options:

• Circular

• Symmetric

• Tree

• Hierarchical

or

Select Layout from the View menu and from the dropdown list, select one of the options displayed, as 
described above.

The map is displayed according to the selected option.

Note Clicking Layout on the toolbar displays the map according to the option last selected. Circular 
is the default layout option.

Saving a Map
Cisco ANA NetworkVision enables you to save map layouts and change existing ones. 

The following changes are saved automatically:

• Addition or removal of a device 

• Addition or removal of a link

• Aggregation or disaggregation of elements

The following changes to the workspace are only saved when the Save option is selected:

• The location of the devices on the map

• The layout

• Thumbnails

• The size of the devices

The maps can then be opened later as required.

To save changes to a map:

Step 1 On the toolbar, click Save Map Appearance,

or

Select Save Map from the File menu. Your changes are saved.
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Saving as a New Map
The user can save a copy of the entire map or parts thereof (specific devices and aggregations) while 
leaving the original map intact.

To save as a new map:

Step 1 Make sure that the map that you want to save is displayed in the Cisco ANA NetworkVision window or 
that the required network elements and/or aggregated nodes are selected in the tree pane and map pane.

Step 2 Right-click in the tree pane or map pane to display the Device shortcut menu. Select Save as New Map. 
The Create Map dialog box is displayed with a default name for the new map.

Step 3 Enter a new name for the map,

or

You can accept the name provided by default.

Step 4 Click OK. The new map is created.

Note For more information about how to open the new map, see Opening a Map, page 4-4.

Saving a Map as an Image
Cisco ANA NetworkVision enables you save the currently displayed map as an image.

To save a map as an image:

Step 1 Select Save As Image from the File menu. The Save as Image dialog box is displayed.
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Figure 4-1 Save as Image Dialog Box

The following fields are displayed in the Image area:

• Type—Enables you to select the type of image required.

Note The file types .svg and .png are not available in this version.

• File Name—Enables you to define a name for the image.

The following checkboxes are displayed in the Image Content area:

• Visible Window Only—Saves only the currently displayed window as an image.

• Draw Grid—This option is not available in this version.

• Selected Objects Only—Saves only the selected network objects as an image.

The Image Characteristics area enables you to define the quality of the image by entering a figure or by 
clicking and dragging the slider.

The following radio buttons are displayed in the Size area:

• Current Zoom Level—Saves the image at the currently selected zoom level. Selecting this radio 
button enables the Visible Window Only checkbox.

• Actual Size—Saves the image at the actual size.

• Fit in Window—Saves the image to fit in the window.

• Custom—Saves the image at an enlarged or reduced size. Selecting this radio button enables the 
Width and Height options.

Step 2 Define the image settings that are required.

Step 3 Click OK. The map is saved, as an image is the defined directory.
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Closing a Map
Cisco ANA NetworkVision enables you to close a map displayed in the map pane whenever required. At 
the same time other maps can be left open in order to work with them. 

To close a map:

Step 1 Select Close from the File menu,

or

Click in the upper right-hand corner of the map in the workspace. 

If changes have been made to the map, an information message is displayed.

Step 2 Click Yes. The map is saved and closed. An empty Cisco ANA NetworkVision window is displayed, or 
the map that was last opened is displayed.

Deleting a Map
Cisco ANA NetworkVision enables you to delete a map from all the views in the Cisco ANA 
NetworkVision window.

To delete a map:

Step 1 On the toolbar, click Open Map,

or

Select Open from the File menu. The Map List dialog box is displayed.

Step 2 From the Map List, select the map that you want to delete.

Step 3 On the toolbar, click Delete Map. An confirmation message is displayed.

Step 4 Click Yes. The selected map is deleted from the Map List dialog box, the Cisco ANA NetworkVision 
window and the database.

Step 5 Click Close to close the Map List dialog box. The Cisco ANA NetworkVision window is displayed.

Note When a map that is open is deleted, a message is displayed to all users of the client that the map 
is being closed and deleted from the database.

Renaming a Map
Cisco ANA NetworkVision enables you to rename a map that is displayed in the Cisco ANA 
NetworkVision window. The name change affects all users of the map and the new name is displayed in 
the Cisco ANA NetworkVision window of all users.
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To rename a map:

Step 1 On the toolbar, click Open Map,

or

Select Open from the File menu. The Map List dialog box is displayed.

Step 2 From the Map List, select the map that you want to rename.

Step 3 On the toolbar, click Rename Map. The Rename Map dialog box is displayed.

Step 4 Enter the new map name.

Step 5 Click OK. The selected map is renamed in the Map List dialog box, in the Cisco ANA NetworkVision 
window and in the database.

Step 6 Click Close to close the Map List dialog box. The Cisco ANA NetworkVision window is displayed.

Resizing a Device
Cisco ANA NetworkVision enables you to define the size of selected devices or aggregated nodes in the 
map pane, according to predefined sizes or according to a percentage of the current size.

Note You can manually resize a node by selecting it and dragging the corner (handle).

To resize a device or aggregated node:

Step 1 Select the devices and/or aggregated node that you want to resize in the map pane.

Note The Resize option is only enabled when devices and/or aggregated nodes are selected. If there 
are any links selected this option is disabled.

Step 2 On the toolbar, click Resize Selected Nodes,

or

Select Resize from the Edit menu.

or

Right-click on the selected devices and/or aggregated node in the map pane to display the Device 
shortcut menu. Select Resize. 

The Resize Nodes Controller dialog box is displayed.

The following fields are displayed in the Resize Nodes Controller dialog box:

• Resize Node—Displays a dropdown list of percentages according to which the map selection is 
resized based on the current size.

• Set Node Sizes—Displays a dropdown list of fixed sizes according to which the map selection is 
resized.

Step 3 Select an option from the Resize Node or Set Node Sizes dropdown list.
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Step 4 Click OK. The selected devices and/or aggregated node are resized.

Viewing the Network
Cisco ANA NetworkVision enables you to display the entire network map or any part of the map in the 
Cisco ANA NetworkVision window.

You can use the Zoom tools or the Overview window to display the part of the map that you require. The 
Overview window enables you to view all the changes and alarms taking place in the network. In 
addition, you can display an aggregated node in a thumbnail. 

To open an overview of the network:

Step 1 On the toolbar, click Overview,

or

Select Overview from the View menu. The Overview window is displayed.

Figure 4-2 Overview Window

Step 2 In the Overview window, select the area that you require by clicking and dragging the mouse to view the 
required area and thereby enlarging it in the map pane. A blue rectangle is displayed around the selected 
area. You can move the selected area by placing the mouse above the rectangle. The mouse icon will be 
changed to a hand, and you can then click and drag the mouse to move the rectangle over the required 
area.

Step 3 Click and drag the rectangle again to select or resize a different network area.

Step 4 Click  to close the Overview window.

In addition, you can display a thumbnail of the selected aggregated node in the map pane, including all 
the aggregated devices. Thumbnails can also be nested.

To display a thumbnail of the node:

Step 1 Right-click on an aggregated node in the map pane to display the Aggregated Node shortcut menu.
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Step 2 Select Show Thumbnail. The thumbnail is displayed in the map pane.

Figure 4-3 Thumbnail

Note To redisplay the aggregated node in the map pane right-click on the thumbnail and select Show 
As Aggregation.

Note To resize the thumbnail select it, and click and drag any of the thumbnail handles.

Viewing a Network Device
Cisco ANA NetworkVision enables you to view any network device in the currently displayed map.

The network device is selected in the map pane and the tree pane. The ticket pane displays all the active 
and cleared tickets, however, the user can filter the tickets so that only the tickets of the selected network 
device are displayed in the ticket pane. 

For more information about filtering tickets by device, see Filtering Tickets by Device, page 8-4.

To view a network device:

Step 1 Click on the device in the tree pane or select the device on the map. 

Note • You can use the Zoom tools when viewing the network, see Cisco ANA NetworkVision Toolbar, 
page 2-18.

• Click Overview on the toolbar to display the network in the Overview window.
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Selecting Map Views
Cisco ANA NetworkVision provides you with various selection tools that can be used to view and 
analyze maps in the map pane.

You can view graphical representations of NEs and various links appearing in the map pane of the 
Cisco ANA NetworkVision window’s workspace using the toolbar buttons.

The Device View and Show Links View buttons open dynamic tables listing network element/device 
information and respective map context links in table-format (not graphical links). The respective tables 
are displayed in the Cisco ANA NetworkVision window’s workspace. For more information on viewing 
and working with device view tables and filtering the links view, see Chapter 3, “Working with 
Cisco ANA NetworkVision Tables”.

Cisco ANA NetworkVision provides you with various selection tools that can be used to view and 
analyze maps in the map pane and the links view table displayed in the workspace as described below.

To select a tool:

Step 1 From the View menu choose the required selection tool,

or

On the toolbar, click the required selection tool.

Button Function

Defines the way in which the map is displayed in the map pane of the 
Cisco ANA NetworkVision window, namely, Circular, Symmetric, Tree or 
Hierarchical. 

Displays the device view in the Cisco ANA NetworkVision window’s 
workspace (the button toggles when selected or deselected).

Displays the links view in the Cisco ANA NetworkVision window (the 
button toggles when selected or deselected). 

Displays the map pane in the Cisco ANA NetworkVision window (the button 
toggles when selected or deselected). 

Activates the normal selection mode (the button toggles when selected or 
deselected).

Activates the pan mode, which enables you to move around in the map pane 
by clicking and dragging (the button toggles when selected or deselected).

Activates the zoom selection mode, which enables you to select an area in the 
map pane to be enlarged by clicking and dragging to view the selected area 
(the button toggles when selected or deselected).

Fits the entire sub-network or map in the map pane.
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Finding a Ticket Source
Cisco ANA NetworkVision enables you to find the source of a ticket displayed in the ticket pane by 
highlighting the device in the tree pane and/or map pane.

To find the ticket source:

Step 1 Right-click on the required ticket in the ticket pane to display the Ticket shortcut menu. 

Step 2 Select Find Source from the Ticket menu. The source of the ticket is highlighted in the tree pane and/or 
map pane.

Note A blue selection box highlights the device that is the source of the ticket.

Step 3 Click anywhere in the tree pane or the map pane to remove the highlight from the selected device or link.

Finding a Link Source
Cisco ANA NetworkVision enables you to find a link displayed in the links view by highlighting the link 
in the map pane.

To find the link:

Step 1 Right-click on the required link in the links view to display the Links View menu. 

Step 2 Select Find Source from the Links View menu. 

The source of the link is highlighted in the map pane.

or

If there are two or more lines that represent the same links, for example, a VRF link, the Select Link 
Context dialog box is displayed. Select the required link context from the dropdown list and click OK. 
The source of the link is highlighted in the map pane.

Note A blue link highlights the source of the link in the map pane.

Step 3 Click anywhere in the tree pane or the map pane to remove the highlight from the selected link.

Finding a Network Device
Cisco ANA NetworkVision enables you to find a device in the map by entering the device name or the 
device IP address or any part thereof.
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To find a device in the map:

Step 1 On the toolbar, click Find in Map, 

or

Select Find in Map from the Edit menu. The Find in Map dialog box is displayed.

The Search all map levels checkbox enables you to search for a device or IP address at all levels of the 
map. This option is selected by default. Clearing this option searches for the device, but excludes device 
aggregations from the search.

Step 2 Enter the device name or the IP address.

Note You can enter a partial name (case sensitive) or IP address. For example, XY will find the devices 
with the names containing the letters XY.

Step 3 Click OK to enable the search in all the maps and sub-networks. A device matching the search criteria 
is displayed on the map.

Step 4 Press F3 to view the next device matching the search criteria.

Aggregating Devices
Cisco ANA NetworkVision enables you to aggregate devices in the map pane.

To aggregate devices:

Step 1 Select the required devices in the map pane,

or

Select the required devices in the tree pane or map pane using <Ctrl> or the selection tool.

Step 2 On the toolbar, click Aggregate,

or

Select Aggregate from the Node menu,

or

Right-click on the selected devices in the tree pane or map pane to display the Device menu. Select 
Aggregate. 

The Aggregation dialog box is displayed prompting you to enter a name for the aggregated node.

Step 3 Enter a unique name for the aggregated node and click OK. The aggregated node is displayed in the tree 
pane and map pane. Aggregated nodes are displayed as a single entity with the Aggregation icon.

The aggregated node icon changes color according to the alarm severity. For more information about 
device colors, see Status of Network Objects, page 2-15.

The aggregated node selected in the map pane and tree pane of the Cisco ANA NetworkVision window 
can be disaggregated.
4-16
Cisco Active Network Abstraction NetworkVision User Guide, Version 3.6

OL-12500-01



 

Chapter 4      Working with Cisco ANA NetworkVision Maps
    Renaming an Aggregated Node
To disaggregate a node:

Step 1 Select the required branch in the tree pane,

or

Select the required aggregated node in the map pane.

Note The Aggregation icon indicates an aggregated node.

Step 2 Select Disaggregate from the Node menu,

or

Right-click on the aggregated node in the tree pane or map pane to display the Aggregated Node shortcut 
menu. Select Disaggregate. 

An information message is displayed.

Step 3 Click Yes. The node is disaggregated.

For more information about resizing an aggregated node, see Resizing a Device, page 4-11.

Renaming an Aggregated Node
Cisco ANA NetworkVision enables you to rename an aggregated node that is displayed in the 
Cisco ANA NetworkVision window.

The name change affects all users of the map and the new name is displayed in the Cisco ANA 
NetworkVision window of all users.

To rename an aggregated node:

Step 1 Select the aggregated node that you want to rename in the tree pane or map pane.

Step 2 Right-click on the aggregated node to display the Aggregated Node menu and select Rename. The 
Rename Node dialog box is displayed.

Step 3 Enter a new name for the aggregated node and click OK. The selected aggregated node is renamed in 
the tree pane and map pane and in the database.

Filtering Links According To Type
The links filter enables the user to filter the links displayed in the map pane and in the links view.
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The user quickly selects the types of links to be filtered by selecting from a predefined set of link types 
in the list or by manually configuring a customized set of link types. The user can either:

• Create a new map, select a filter and then add the devices to the map. This filter will then be applied 
to the new map and only the required link types will be visible in the map pane and the links view
(method 1)
or

• Create a map and add the devices with all the links enabled and visible in the map pane and links 
view. The user can then filter (display or hide) the different types of links required (method 2).

Note By default all the link types are displayed in the map pane and links view until the links filter is applied.

Note The filter only applies to the map pane and the links view; it has no affect elsewhere in Cisco ANA 
NetworkVision. Since the filtered links are removed from the map, it also has an affect on the severity 
of the network elements.

To filter links according to type (method 1):

Step 1 On the toolbar, click New Map,

or

Select New Map from the File menu.

The Create Map dialog box is displayed. For more information see Creating a New Map, page 4-3.

Step 2 Click Advanced. The Map Options dialog box is displayed.

Figure 4-4 Map Options Dialog Box
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Note By default all the link types are selected in the Map Options dialog box, namely, all the links are 
displayed in the map pane and links view.

The Map Options dialog box displays a list of all the types of links that can be filtered by the user in the 
map pane.

The Group dropdown list contains the following options:

• Custom—Only the links defined for the customized filter are displayed in the map pane.

• All—All the links are displayed in the map pane.

• Data Link—The data link layer class of links is displayed in the map pane, namely, ATM and FR.

• None—None of the links are displayed in the map pane.

• Physical—Only the physical links are displayed in the map pane.

• VPN—Only the VPN links are displayed in the map pane.

ATM, VPN, MPLS, and Ethernet are just some of the options displayed in the Map Options dialog box 
that can be used to filter the links displayed in the map pane and in the links view.

Note The Group dropdown list options can be customized by selecting an option and adding or 
removing the required link types. The next time the Map Options dialog box is opened the 
Custom option is displayed with the required link types.

Step 3 Select or clear the checkbox(es) for the links that you want or do not want to display in the map pane 
and links view.

Step 4 Click OK/Apply to apply the defined link filter settings.

Step 5 Enter a name for the new map and click OK. An empty new map is displayed in the tree pane and map 
pane.

Step 6 Add the required devices to the network. For more information see Adding a Device, page 4-5. 

The links are displayed in the map pane and links view according to the defined filter criterion.

A user can also create a map and add the devices with all the links enabled and visible in the map pane 
and links view. The user can then filter (display or hide) the different types of links required.

To filter links according to type (method 2):

Step 1 On the toolbar, click Map Options. The Map Options dialog box is displayed.

Step 2 Clear the checkbox(es) for the links that you do not want to display in the map pane and links view.

Step 3 Click OK/Apply to apply the defined link filter settings. The links are displayed in the map pane and 
links view according to the defined filter criterion

.
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Opening the CPU Usage Graph 
Cisco ANA NetworkVision enables you to display memory and CPU usage information for a 
device/network element, including its history.

To open the CPU usage graph:

Step 1 Right-click on a device/network element in the tree pane or map pane to display the Device shortcut 
menu.

Step 2 Select Tools | CPU Usage. The CPU Usage dialog box is displayed.

The following areas are displayed in the CPU Usage dialog box:

• CPU Usage—The CPU usage rate as a percentage.

• CPU Usage History—The CPU usage rate history is graphically displayed.

• Memory Usage—The memory usage rate as a percentage.

• Memory Usage History—The memory usage rate history is graphically displayed.

The following tool is displayed in the dialog box:

Step 3 Click Close to close the CPU Usage dialog box.

Communicating with Devices 
Cisco ANA NetworkVision enables you to communicate with devices in the following ways:

• Pinging the Device

• Telneting the Device

Pinging the Device
Cisco ANA NetworkVision enables you to ping the device in order to check whether the device is 
responding.

Note The ping is performed from the client to the device, and not from the ANA Unit hosting the VNE to the 
device.

To ping the device:

Step 1 Select the required device in the tree pane or map pane in the workspace.

Step 2 Right-click on the required device to display the Device shortcut menu.

Exports all the information currently displayed in the dialog box. This 
information can then be viewed at a later stage. For more information see 
Exporting the Table to a File, page 3-5.
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Step 3 Select Tools | Ping. The Ping window is displayed and the device is pinged.

Telneting the Device
Cisco ANA NetworkVision enables you to communicate with the device using the Telnet window.

Note The telnet is performed from the client to the device, and not from the ANA Unit hosting the VNE to the 
device.

To telnet the device:

Step 1 Select the required device in the tree pane or map pane in the workspace.

Step 2 Right-click on the required device to display the Device shortcut menu.

Step 3 Select Tools | Telnet. The Telnet window is displayed.

Step 4 Complete the necessary communication with the device.

Previewing a Map
Using Cisco ANA NetworkVision you can preview a map before it is printed.

To preview a map:

Step 1 Display the map that you want to print in the map pane.

Step 2 Select Print Preview from the File menu. The Print Preview dialog box is displayed with the active map.

The following buttons are displayed in the Print Preview dialog box:

• Print—Prints the displayed network/map to the selected printer.

• Print Setup—Opens the Print Setup dialog box enabling you to define how the network/map is 
printed. For more information see Defining the Print Setup, page 4-22.

• Zoom In—Zooms in on the network/map.

• Zoom Out—Zooms out of the network/map.

• Zoom %—Zoom in to get a close-up view of your network/map or zoom out to see more of the 
network/map at a reduced size. Click the arrow next to the Zoom box and the zoom setting that you 
want.

• Fit In Window—Displays the entire network/map in the Print Preview dialog box.

• Close—Closes the Print Preview dialog box.

Step 3 Click Print. The required map is printed to the selected printer.
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Defining the Print Setup
Cisco ANA NetworkVision enables you to define the print setup of a map before it is printed.

To define the print setup:

Step 1 Open the Print Preview dialog box, see Previewing a Map, page 4-21.

Step 2 Click Print Setup. The Print Setup dialog box is displayed.

Figure 4-5 Print Setup Dialog Box

The following radio buttons are displayed at the top of the Print Setup dialog box:

• Print Entire Graph—Prints the currently displayed map, including aggregated nodes.

• Print Current Window—Prints the currently displayed map, excluding aggregated nodes.

• Print Current Selection—Prints the area selected in the currently displayed map.

The following radio buttons are displayed in the Scale By area, enabling you to define the number of 
pages and size at which the map is printed:

• Pages—Prints the currently displayed map according to the numbers specified in the Page Columns 
and Page Rows fields.

• Actual Size—Prints the currently displayed map at the actual size.

• Zoom Level—Prints the currently displayed map according to the selected zoom level.

The following checkbox is displayed in the Caption area:

• Print Caption—Select this option to add a caption to the printed map and enter the required text in 
the field below.

The following field is displayed in the Caption area:

• Position—Defines the position of the caption in the printed map.

The Margins area enables you to define the print margins of the map.
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The following checkboxes are displayed in the Multipage Printing area:

• Print Page Numbers—Prints the map with page numbers.

• Print Crop Marks—Prints the map with crop marks.

The following checkboxes are displayed in the Other area:

• Print Border—Prints a border around the printed map.

• Print Background—Prints the background of the currently displayed map.

• Print Grid—Prints a grid for the printed map.

The following buttons are displayed in the Print Setup dialog box:

• Default—Restores the default print settings.

• Page Setup—Defines the page setup settings for printing.

Step 3 Define the print setup as required.

Step 4 Click OK. Now that you have defined the print setup you can print the map. For more information see 
Printing a Map, page 4-23.

Printing a Map
Cisco ANA NetworkVision enables you to print the map that is currently displayed.

To print a map:

Step 1 Select Print from the File menu.

or

Click Print in the Print Preview dialog box. For more information about the Print Preview dialog box, 
see Previewing a Map, page 4-21.
4-23
Cisco Active Network Abstraction NetworkVision User Guide, Version 3.6

OL-12500-01



 

Chapter 4      Working with Cisco ANA NetworkVision Maps
    Printing a Map
4-24
Cisco Active Network Abstraction NetworkVision User Guide, Version 3.6

OL-12500-01



 

Cisco Active Network
OL-12500-01
C H A P T E R 5

Viewing Device Properties

This chapter describes how to view the properties of a device in any mapped network and also provides 
a description of these device properties. 

• Viewing Device Properties, page 5-1, describes how to view the properties of a selected device.

• Viewing VNE Properties, page 5-3. For more information, refer to the Cisco Active Network 
Abstraction Administrator Guide.

Viewing Device Properties
Cisco ANA NetworkVision enables you to view the properties of a selected device using the Properties 
dialog box. For example, you can view the Vendor and Location of a device.

To view device properties:

Step 1 Right-click on a device in the tree pane or map pane or device view in the workspace to display the 
Device shortcut menu. Select Properties.

The Properties dialog box is displayed. 
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Figure 5-1 Properties Dialog Box

The device icon and name are displayed at the top of the Properties dialog box. In addition, the severity 
of the selected network device is displayed using the severity colors palette. The following fields are 
displayed in the Properties dialog box:

• Vendor—The vendor name, as defined in the device's MIB.

• Product—The product name of the device, as defined in the device's MIB, for example, Router.

• IP Address—The IP address used for managing the device.

• System Name—The name of the device, as defined in the device’s MIB. 

• Up Since—The date and time when the device was last reset.

• Contact—The name of the contact person for the device, as defined in the device's MIB.

• Location—The physical location of the device, as defined in the device's MIB.

• Software Version—The details of the software version.

• System Description—A description of the system taken from the device.

• Element Type—The device type (manufacturer name), for example, Cisco 7200.

The VNE button displayed in the Properties dialog box opens the VNE Properties dialog box enabling 
you to edit the VNE’s properties, including starting and stopping the VNE, maintenance and configuring 
polling rates. For more information, refer to the Cisco Active Network Abstraction Administrator Guide.

Step 2 To close the device Properties dialog box, click . 
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Viewing VNE Properties 
Click the VNE button to view more information about the VNE. For more information about VNE 
Management, such as adding new VNEs to a network and modifying the status of a VNE, refer to the 
Cisco Active Network Abstraction Administrator Guide.
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Viewing Network Device Inventory

This chapter describes how to view the physical and logical inventory of a selected device in any mapped 
network and provides a description of both. In addition, it briefly describes the DLCI, VC and Cross 
Connect tables.

The Cisco ANA solution maintains continuous, real-time discovery of all the physical and logical 
entities of the network inventory and the relationships between them. It automatically reflects every 
addition, deletion and modification that occurs in the network in its distributed system inventory.

Note The window displayed for all the devices is similar in appearance however the information that can be 
viewed for each device may vary. 

The Inventory window also enables the user to view all the tickets that are collected on the selected NE 
in the ticket pane. For more information see Ticket Pane, page 6-5.

• Opening the Inventory Window, page 6-1, describes how to open the Inventory window. In addition, 
it describes the Inventory window, including the tree pane, device view panel, toolbar, ticket pane 
and workspace.

• Viewing Physical Inventory, page 6-5, describes how to view the physical inventory of a selected 
device and port functionality. In addition, it describes opening the port utilization graph, and 
managing port alarms. 

• Viewing Logical Inventory, page 6-7, describes how to view the logical inventory of a selected 
device.

• Opening the DLCI/VC/Cross Connect Table, page 6-8, describes how to open the DLCIs/VCs/Cross 
Connect information table on a selected port.

Opening the Inventory Window 
The Inventory window enables you to perform the following functions:

• View physical and logical inventory information.

• View tickets for the device.

• Open the port utilization graph.

• Open the DLCI, VC and Cross Connect tables.

• Open the Cisco PathTracer.

• Add or remove links.
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• Manage the alarms being sent on a port.

• Open the Command Builder to create customized commands.

• Open the Soft Properties Manager to extend the amount of information displayed. For more 
information see Cisco Active Network Abstraction Customization User Guide.

For more specific information on MPLS-TE (Traffic Engineering) tunnels and Cisco ANA Network’s 
Traffic Engineering Tunnel viewing capabilities, see Cisco Active Network Abstraction Managing MPLS 
User Guide.

To open the Inventory window:

Step 1 Double-click on a device in the tree pane or map pane,

or

Select a device in the tree pane or map pane or device view and on the toolbar click ,

or

Right-click on a device in the tree pane or map pane to display the Device shortcut menu and select 
Inventory. 

The Inventory window for the selected device is displayed.

Figure 6-1 Inventory Window

1 Viewing VNE properties

2 Properties pane including tabs and tables
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• To view Physical Inventory information, open the  Physical Inventory branch.

• To view Logical Inventory information, open the  Logical Inventory branch. For more 
information about Logical Inventory information see Viewing Logical Inventory, page 6-7.

Note Click in the right-hand top corner to close the Inventory window.

The Inventory window displays the physical and logical inventory for the selected device. The Inventory 
window is divided into the following areas:

• Tree Pane.

• Device View Panel.

• Device View Panel Toolbar.

• Ticket Pane.

• Information Tabs and Tables in the Properties Pane.

All the areas displayed in the Inventory window are correlated; this means that selecting an option in one 
area affects the information displayed in the other areas. 

The information displayed in the Inventory window changes according to the network element or 
network element component selected in the tree pane. 

For more information about the right-click shortcut menus that are displayed in the Inventory window 
see Shortcut Menus, page 2-25.

Tree Pane
The tree pane displays a tree-and-branch representation of the selected device and all its modules. The 
tree pane is divided into two main branches, namely, Logical Inventory and Physical Inventory.

The window heading and the highest level of the tree pane displays the name of the VNE given to the 
device as defined in Cisco ANA Manage. The highest level of the tree pane also displays the device icon 
and status. For more information about icons see Appendix A, “Icon Reference”.

The color of the device icon in the tree pane reflects its severity. In addition, the color of the network 
element component in the device view panel is the same as the color of the network element component 
in the tree pane. For more information about severity and status see Status of Network Objects, 
page 2-15.

The branches of the tree pane display the different network element components, for example, a chassis, 
card and so on. When a network element component is selected in the tree pane, the information 
displayed in the Information tabs and tables in the properties pane is updated. The branches in the tree 
pane can be expanded and collapsed in order to display and hide information as needed.

3 Status bar

4 Ticket pane

5 Device view panel

6 Device view panel toolbar

7 Tree pane
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The table below displays the different network element component icons used to display physical 
inventory in the tree pane of the Inventory window:

For more information about the device icons displayed see Appendix A, “Icon Reference”. A business 
tag can be attached to the selected network element component by right-clicking. For more information 
about business tags see Chapter 10, “Working with Business Tags”.

For more information about the right-click menus that are displayed in the tree pane of the Inventory 
window see Shortcut Menus, page 2-25.

Device View Panel
The device view panel displays a graphical representation of the front view of the selected device. The 
colors displayed in the device view panel reflect the colors of the network element components in the 
tree pane. For example, if a port is down and is colored red in the tree pane, the same port is colored red 
in the device view panel.

Clicking on a network element component in the device view panel displays the properties of the selected 
component in the Information tabs and tables in the properties pane and selects the same network 
element component in the tree pane.

Device View Panel Toolbar
The Inventory window contains the following tools that are connected to the device view panel:

Table 6-1 Physical Inventory Icons

Icon Device

Chassis

Shelf

Slot/Sub-slot

Port/Logical Port

Unmanaged Port

Displays an enhanced view of the network element components within the device 
in the browse box as you move over the device view panel with the selection tool.

Fits the entire view of the device displayed in the device view panel.
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Ticket Pane
The ticket pane is displayed at the bottom of the Inventory window. The tickets displayed relate to the 
element selected in the tree pane. For more information about the ticket pane, see Ticket Pane, page 2-13.

Note The ticket pane can be displayed or hidden by clicking the arrows displayed below the device view panel.

Information Tabs and Tables in the Properties Pane
The Information tabs and tables in the properties pane enable you to view physical and logical inventory 
information, depending on your selection in the tree pane or device view panel, for example, chassis or 
port information. The inventory information displayed in the Inventory window varies according to the 
device or network element component selected in the tree pane.

The properties pane displays context-sensitive tabs and toolbars; the tools displayed depend on your 
selection in the tree pane or device view panel. For example, when an ATM port is selected the Show VC 
Table tool is displayed on the toolbar.

In addition, the user can display the properties of a row in a table by double-clicking on the row in the 
table or by right-clicking it and selecting Properties from the shortcut menu.

For more information about the toolbar displayed in the table of the properties pane see Chapter 3, 
“Working with Cisco ANA NetworkVision Tables”.

Viewing Physical Inventory 
Each device that is managed by Cisco ANA is modeled in the same manner. The physical inventory 
reflects the physical components of the managed network element. Cisco ANA NetworkVision enables 
the user to view physical inventory information for the following modules:

• Device—For a detailed description of device properties see Viewing Device Properties, page 5-1.

• Chassis

• Shelves

• Slots

• Sub-Slot

• Ports, including logical ports

Physical inventory is continuously updated for both status and configuration. The addition of a new card, 
removal of a card or any change to the device is reflected by the VNE and updated instantly.

The system also includes built in properties (system properties) for each network element. This includes 
information such as MAC address, MTU and Media Type.

Note The window displayed for all the devices is similar in appearance, however the network element 
components contained in each device can vary, for example, chassis, shelf, sub-port and so on. 

The information displayed in the Inventory window changes according to the device type, device and 
network element component selected in the tree pane.
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The following buttons may be displayed in the Inventory window for physical inventory:

• Show DLCI Table | Show VC Table | Show Cross Connect Table—Displays the DLCI/VC/Cross 
Connect Table of the selected port. For more information see Opening the DLCI/VC/Cross Connect 
Table, page 6-8.

• Open Port Utilization Graph—Displays the selected port traffic statistics, namely, Rx/Tx Rate and 
Rx/Tx Rate History. For more information see Opening the Port Utilization Graph, page 6-6.

• Disable Sending Alarms—Enables the user to manage the alarms on a port. For more information 
see Managing Port Alarms, page 6-6.

For information about configuring topology from a port see Adding a Link, page 7-6.

Opening the Port Utilization Graph
Cisco ANA NetworkVision enables you to display the online information of a port, namely, Rx/Tx Rate 
and Rx/Tx Rate History.

To open the port utilization graph:

Step 1 Open the Inventory window and select the required port.

Step 2 Click Open Port Utilization Graph in the properties pane. The Port Statistics dialog box is displayed.

The following areas are displayed in the Port Statistics dialog box:

• Rx Rate—The reception rate as a percentage.

• Rx Rate History—The reception rate history is graphically displayed.

• Tx Rate—The transmission rate as a percentage.

• Tx Rate History—The transmission rate history is graphically displayed.

Step 3 Click  to close the Port Statistics dialog box.

Managing Port Alarms 
The user can enable or disable the alarms on a selected port. By default, alarms are enabled on all ports. 
When the alarms are disabled on a port, no alarms will be generated for the port and they will not be 
displayed in the ticket pane.

To disable a port alarm:

Step 1 Open the Inventory window to select the required port. 

Step 2 Right-click the required port to display the shortcut menu, and select Disable Sending Alarms,

or

On the toolbar of the properties pane, click Disable Sending Alarms.

The Sending Alarms field in the Location Information area of the Context pane displays the value false. 
This indicates that the alarm for the required port has been disabled. In addition, the toolbar in the 
properties pane now displays the Enable Sending Alarms tool.
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The user can enable the alarms on a port at any time.

To enable a port alarm:

Step 1 Open the Inventory window to select the required port.

Step 2 In the properties pane click Enable Sending Alarms. 

The Sending Alarms field in the Location Information area of the properties pane displays the value true. 
This indicates that the alarm for the required port has been enabled.

In addition, the toolbar in the properties pane now displays the Disable Sending Alarms tool.

Viewing Logical Inventory 
Cisco ANA NetworkVision enables you to view logical inventory information. Cisco ANA maintains 
logical inventory for each device. The logical inventory reflects dynamic data such as configuration data, 
forwarding and service-related components, which affect traffic handling in the device. 

The information displayed in the Inventory window changes according to the device type and branch 
selected in the tree pane. 

Logical Inventory Window
Logical inventory information is displayed in the Inventory window, which can be divided into tabs, for 
example, Traffic Descriptors and Forwarding Component Containers tabs, as shown in the example.

Figure 6-2 Logical Inventory Information Displayed in the Inventory Window
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Note For more information about opening the Inventory window see Opening the Inventory Window, 
page 6-1.

The Traffic Descriptors tab enables you to view the profiles for which logical inventory information can 
be displayed, for example, Frame Relay Traffic Profiles and ARP Entities.

The logical device information is also updated in the model of the network element in order to accurately 
reflect the traffic handling which is being performed by the device at any time.

The Forwarding Component Containers tab enables you to view a list context profiles for which logical 
inventory information can be displayed, for example, VRFs and Routing Entities.

Note Cisco ANA NetworkVision now provides enhanced support for the Generic SNMP VNE. The user can 
now view Bridge and ARP table information.

Opening the DLCI/VC/Cross Connect Table 
The DLCI/VC/Cross Connect Table enables you to view a table of DLCIs/VCs/Cross Connect 
information on a selected port. For example, the Cross Connect table enables you to view in and out port 
cross connect information, including cross connect information for unmanaged networks, Frame Relay 
and ATM devices.

To open the DLCI/VC/Cross Connect table:

Step 1 Right-click on a device in the tree pane or Context pane to display the Device shortcut menu.

Step 2 Select Inventory. The Inventory window for the selected device is displayed.

Step 3 Open the Physical Inventory branch and drill down to the required port.

Step 4 Click Show DLCI Table/Show VC Table/Show Cross Connect Table on the toolbar of the Context 
pane. The relevant dialog box is displayed.
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Working with Links

This chapter describes how to view information about the physical links between ports and sub-ports. In 
addition, it describes adding and removing links between devices.

• Opening Link Properties, page 7-2, describes how to open the Link Properties dialog box.

• Monitoring Link Properties, page 7-3, describes the Link Properties dialog box and how to view 
information about the physical links between ports.

• Viewing Impact Analysis, page 7-4, describes how the user can select a network link and calculate 
the potentially affected parties in the event of the selected link going down.

• Adding a Link, page 7-6, describes how to add links between devices.

• Working in Links View, page 7-8, describes the links view, including how to filter the links.

The Cisco ANA solution enables the continuous automatic discovery of connectivity between all 
network elements. Using the automatic discovery mode, all the links in the network are discovered 
automatically. Auto-discovery is an ongoing process that maintains the real topology information of the 
network. Cisco ANA NetworkVision discovers any new links that are added and continues to verify that 
the discovered links still exist.

Link properties are displayed for the following types of links:

• Between two devices.

• Between a device and an aggregation of devices or aggregation of aggregations, which connects this 
device to another device inside the aggregation(s).

• Between two aggregations, which contains devices that cross the aggregations.

The links or aggregated links presented in the map pane:

• Display arrowheads if they are unidirectional

• Have no arrowheads if they are bi-directional

In addition, the links displayed in the map pane have tool tips that provide the user with information 
regarding the number of links and partially describe the list of links. Physical links are highlighted bold. 
The links displayed in the map pane can be filtered. For more information see Filtering Links According 
To Type, page 4-17.
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Opening Link Properties 
The properties of the physical links between two ports are viewed using the Link Properties dialog box. 
ATM, Frame Relay, Ethernet and Serial are some of the examples of the technologies that Cisco ANA 
currently supports links. 

Note The color of a selected link is customizable. The default color is blue. For more information on link 
colors see Chapter 2, “Getting Started”.

To open link properties:

Step 1 Select a link between two devices in the map pane.

Step 2 Right-click on the selected link to display the Link shortcut menu.

Step 3 From the Link shortcut menu, select Properties, 

or

Double-click on the link. The Link Properties dialog box is displayed.

Figure 7-1 Link Properties Dialog Box
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Note If there are a few links between the devices or aggregations, the Link Properties dialog box 
displays the information of all the links.

Step 4 Click Close to close the Link Properties dialog box. The Cisco ANA NetworkVision window is 
displayed.

Monitoring Link Properties
The Link Properties dialog box is divided into the following areas:

• Link List Pane

• Properties Pane

• Ticket Pane

All the areas displayed in the Link Properties dialog box are correlated; this means that selecting an 
option in one area affects the information displayed in the other areas. 

The information displayed in the Link Properties dialog box changes according to the ports or sub-ports 
selected in the Link List pane. 

Link List Pane
The Link List pane displays a list of the links that are represented by a single link on the map. Each link 
has a single entry in the Link List pane.

When a branch is selected in the Link List pane, the information displayed in the properties pane is 
updated. The color of the icon in the Link List pane reflects its severity. For more information about 
severity see Status of Network Objects, page 2-15.

The heading and the Link List pane display the left and right link identifiers between the two nodes, the 
device alias and CTP.

Properties Pane
The properties pane enables you to view the following, depending on your selection in the Link List 
pane:

• Properties of a selected link, including port properties information

• Hyperlink to ports inventory access

• Status

1 Properties pane

2 Status bar

3 Ticket pane

4 Link List pane
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The properties pane displays the connection information type, port alias and port location (a hyperlink) 
information, all which uniquely identify the port. Port location information is also displayed as a 
hyperlink to the Inventory window. 

The properties pane displays the parameters for the different sides of the link, aligned under the relevant 
link identifier. Any discrepancies between the link’s ports are colored red.

The properties pane enables you to view the statistics of the traffic on the link. The following fields are 
displayed in the Connection Information area:

• Type—The type of connector, for example, fiber optic.

• Sending Alarms—The status of alarms on the port of the device, enabled (true) or disabled (false).

• Port Alias—The name used in the device CLI or EMS for the selected port.

• Location—The location of the entity, slot number and port on the slot, as a hyperlink that opens the 
properties of the relevant location.

The following fields may be displayed in the properties pane:

• Oper Status—The operation status, Up or Down.

• Admin Status—The port configuration, Up or Down.

• Port Type—The specific port type, for example, OC3 or Ethernet.

• Maximum Speed—The maximum port speed in Mbps.

• Media Type—The type of cable used, for example, fiber optic.

• MAC Address—The MAC address.

• Distribution Protocol Type—The distribution protocol type, for example, LDP.

The following buttons are displayed in the Affected Parties area for physical links:

• Calculate Affected—Calculates and retrieves the total number of potentially affected entities.

Note This button is displayed when selecting a physical layer Link.

• Show Affected—Displays the properties of the affected parties after clicking Calculate Affected.

Note This button is enabled when the Calculate Affected button is clicked.

Viewing Impact Analysis
Cisco ANA NetworkVision enables the user to select a network link and calculate the potentially 
affected parties (proactive impact analysis) in the event of the selected link going down, the fault has not 
actually occurred).

Note This section only applies to physical links.

To calculate impact analysis:

Step 1 Select a context in the tree pane, and click Links View on the toolbar. The links view is displayed in the 
workspace.
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Step 2 On the toolbar, click Map Options. The Map Options dialog box is displayed. For information about the 
Map Options dialog box see Filtering Links According To Type, page 4-17.

Step 3 Select Physical from the Group dropdown list, and click OK. Only the physical links for the selected 
context are displayed in the links view.

Step 4 Select the required physical link in the links view.

Step 5 Right-click on the selected link to display the shortcut menu, and select Properties. The Topological 
Link Properties window is displayed.

Figure 7-2 Topological Link Properties Window

Step 6 Click Calculate Affected. The total number of potentially affected parties is displayed in the Affected 
Parties area.

Step 7 Click Show Affected. The Affected Parties dialog box is displayed.
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Figure 7-3 Affected Parties Dialog Box

Step 8 Click in the upper right corner to close the Affected Parties dialog box.

Step 9 Click in the upper right corner to close the Topological Link Properties dialog box. The Cisco ANA 
NetworkVision window is displayed.

Adding a Link
Cisco ANA NetworkVision enables you to manage the links between devices (topology), to add a new 
static link between two devices.

A dynamic link is a link that is detected by Cisco ANA and connected automatically. A static link is a 
link that you can manually enter.

Cisco ANA NetworkVision enables you to add a static link by selecting a device or port and defining it 
as the A side. A second device or port is then defined as the Z side. 

Cisco ANA validates the new link after the two ports are selected. Validation checks the consistency of 
the port types (for example, RJ45 on both sides), and Layer 2 technology type (for example, ATM OC-3 
on both sides). 

When adding a new link the state of the link reflects its current state. For example, if the operation status 
of a port is down, the link is colored red.

You can add links from either the Cisco ANA NetworkVision window’s Tree and map pane (method 1), 
or from the Inventory window tree pane (method 2). 
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In addition, a new link can be added using Cisco ANA Manage. For more information refer to the 
Cisco Active Network Abstraction Administrator Guide.

To add a link (method 1):

Step 1 Right-click on the required A Side device in the tree pane or map pane of the Cisco ANA NetworkVision 
window’s workspace to display the right-click shortcut menu, and select Topology | Mark as A Side. 

Step 2 Right-click on the required Z Side device in the tree pane or properties pane to display the right-click 
shortcut menu and select Topology | Mark as Z Side. The Create Static Link dialog box is displayed 
enabling you to select the port to be connected.

Figure 7-4 Create Static Link Dialog Box

Step 3 Drill down and select the required port on the A Side device and Z Side device.

Step 4 Click Create to validate the connection and create the new link. A success message is displayed.

Note A warning message is displayed if:
One of the validation checks fails
The operation status of one port is Up and the other port is Down
The ports selected are not of the same type
The Layer 2 technology type is not the same
If one of the ports is part of another link
Click No to cancel the connection.

Step 5  Click Close to display the Cisco ANA NetworkVision window again.
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To add a link (method 2):

Step 1 Open the Inventory window for the required A Side device.

Note For more information about opening the Inventory window see Opening the Inventory Window, 
page 6-1.

Step 2 Drill down to the required port in the Inventory window tree pane.

Step 3 Right-click on the required A Side port to display the right-click shortcut menu and select Topology | 
Mark as A Side. 

Step 4 Repeat steps 1-2 for the Z Side device.

Step 5 Right-click on the required Z Side port to display the right-click shortcut menu and select Topology | 
Mark as Z Side. A confirmation message is displayed.

Step 6 Click Yes. The ports are connected, and a new link is created between the selected ports.

Note A warning message is displayed if:
One of the validation checks fails
The operation status of one port is Up and the other port is Down
The ports selected are not of the same type
The Layer 2 technology type is not the same
If one of the ports is part of another link
Click No to cancel the connection.

For information about removing a static link, refer to the Cisco Active Network Abstraction 
Administrator Guide.

Working in Links View
The links view provides you with an easy to access complete table list of the various types of physical 
links displayed on the map (the links shown in the map pane are a summary of the many links starting 
from one side and ending at the other side of the link) and their status.

Note Business links are not currently supported in the links view. For more information about business links 
refer to the Cisco Active Network Abstraction Managing MPLS User Guide.

Click Show Links View to display the links view in the Cisco ANA NetworkVision window. The links 
view is displayed.

Note An external link to the network has a gray cell background in the table, and you can open the Inventory 
window by clicking on the hyperlink. For more information about external links, see Working in Links 
View, page 7-8.
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Any links that are added or removed from the map are automatically added or removed from the links 
view provided they have not been filtered out. 

The links view displays the selected filtered links and the new location in the tree pane:

• When the user navigates in the tree pane or,

• When the user selects devices and/or aggregated nodes in the map pane.

The following columns are displayed in the links view:

• Context—The name of the map, aggregated node or sub-aggregated node containing the link (there 
may be multiple contexts).

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm on 
the link. This indicates the impact of the alarm on the network. For more information about severity, 
see Status of Network Objects, page 2-15.

• A End-Point—The device or site that is the source of the link as a hyperlink to the inventory of the 
device or site.

• Bi Directional—The direction of the link, true (bi-directional) or false (unidirectional).

• Z End-Point—The device or site that is the destination of the link as a hyperlink to the inventory 
of the device or site.

• Link Type—The type of link, for example, Physical Layer, VPN or MPLS.

Note • Clicking on a red triangle displayed in a cell expands the cell to display all the information.

• Clicking on a header in the links view sorts the information displayed, for example, according to 
Severity.

The links displayed in the links view are by default sorted according to Link Type and Deep collection 
method. In addition, the links view can be sorted: 

• According to a column by clicking on the required column heading. The  icon is displayed next 
to the selected column heading.

• In ascending or descending order by clicking on the column heading or the Sort Table Values  button 
on the toolbar. A triangle is displayed next to the selected column heading. For more information 
see Finding Text in a Table, page 3-2.

The Location field displays the number of selected rows and the total number of rows in the table, for 
example, 2/16 Selected. In addition, it displays the location of the selected row(s) in the table, for 
example, Line 3.

The Find field enables you to search for information in the links view table according to the selected 
column.

For more information about the standard buttons displayed in Cisco ANA NetworkVision’s tables and 
table functionality see Opening a Map, page 4-4.

The following additional buttons are displayed at the top of the links view and enable you to filter the 
links using the collection method:
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For more information about filtering links using the collection method see Filtering Links Using the 
Collection Method, page 7-10.

Some of the functions that can be performed in the links view are:

• View all the links or only the filtered links of a selected context using the collection methods, All, 
External, Flat and Deep. For more information see Filtering Links Using the Collection Method, 
page 7-10.

• View and filter the links according to type using the Map Options dialog box. For more information 
see Filtering Links According To Type, page 4-17.

• Locate the source of a link in the map. For more information see Finding a Link Source, page 4-15.

• Sort the links displayed.

• View link properties.

Filtering Links Using the Collection Method
The links view table is a very powerful tool allowing you to “view” NEs links that you cannot see 
visually or graphically in the map pane in the Cisco ANA NetworkVision window’s workspace. The 
links view table is dynamic and automatically refreshes itself, allowing you to view up to date network 
links in real-time. 

The collection method enables you to filter the links displayed in the links view based on the selected 
context (map, aggregation or sub-aggregation). By selecting the collection method from the toolbar in 
the links view table, the user can quickly filter the links.

Note • By default the Deep collection method is applied in the links view.

• The filter only applies to the links view; it has no effect elsewhere in Cisco ANA NetworkVision.

For more information about the buttons displayed in the links view, see Working in Links View, page 7-8.

For more information about filtering links according to type, see Filtering Links According To Type, 
page 4-17.

Table 7-1 Links View Tools

All Links—Displays the complete list of links for the selected context (map, 
aggregation, or sub-aggregation).

External Links—Displays the links where only one side of the link starts in 
this context (map, aggregation or sub-aggregation) and the other side ends 
somewhere else not in the map or outside of the currently selected context.

Flat Links (Surface)—Displays the links currently visible on the map for the 
selected context (map, aggregation or sub-aggregation), excluding any 
thumbnails.

Deep Links—Displays the links for the current aggregations and the 
sub-aggregations where both of the endpoints are somewhere within the 
currently selected context.
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To filter links according to the collection method:

Step 1 In the Cisco ANA NetworkVision window’s toolbar, click Links View to display the links view in the 
Cisco ANA NetworkVision window’s workspace.

Step 2 Select the required context in the Cisco ANA NetworkVision window’s tree pane or links view in the 
Cisco ANA NetworkVision window’s workspace.

Step 3 In the links view toolbar select one of the following collection method options:

• All Links

• External Links

• Flat Links

• Deep Links

The links are displayed in the links view according to the defined collection method.

Cisco ANA NetworkVision also enables you to find the source of a link displayed in the links view by 
highlighting the link in the map pane. 

To find the links source:

Step 1 Right-click on the required link in the links view to display the Links View menu. 

Step 2 Select Find Source from the Links View shortcut menu. The source of the link is highlighted in the map 
pane,

or

If there are two or more links that are the same, for example, a VRF link, the Select Link Context dialog 
box is displayed. Select the required link context from the dropdown list, click OK. The source of the 
link is highlighted in the map pane.

Note A blue link highlights the source of the link in the map pane.

Note Click the NE in the tree pane or the link in the map pane to remove the highlight from the 
selected link.
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Working with Tickets

This chapter describes how Cisco ANA NetworkVision correlates alarms and how to view the tickets and 
ticket properties, including correlated alarms, active alarms and alarm history. In addition, it describes 
ticket management, for example, acknowledging a ticket.

• About Alarms, page 8-1, describes the ability to correlate related alarms and detect the root cause.

• Filtering Tickets by Device, page 8-4, describes how to filter the tickets that are shown in the ticket 
pane so that only the tickets of a selected device or network element are displayed.

• Filtering Tickets by Criteria, page 8-4, describes how to filter the tickets that are shown in the ticket 
pane according to various criteria.

• Opening Ticket Properties, page 8-6, describes how to view ticket properties.

• Viewing a Detailed Report for the Affected Pair, page 8-12, describes how to view a detailed report 
for every affected pair.

• Acknowledging a Ticket, page 8-13, describes how to acknowledge tickets using the ticket pane.

• Clearing a Ticket, page 8-14, describes how to clear a ticket.

• Removing a Ticket, page 8-14, describes how to remove a ticket.

• Ticket Status in the Ticket Pane, page 8-15, describes the different ways in which a ticket is 
displayed in the ticket pane depending on the status or severity of the alarm and what affect 
manipulating the ticket has on the way in which the ticket is displayed in the ticket pane.

Cisco ANA NetworkVision enables you to view and acknowledge tickets using the ticket pane. For more 
information, see Ticket Pane, page 2-13.

About Alarms
Cisco ANA provides the ability to correlate related alarms and events and accurately detect the root 
cause. The following scenarios are supported by Cisco ANA and illustrate alarm correlation:

• Correlating an event to the actual network element that created the event, that is a device, interface, 
and so on.

• Correlating a clearing alarm with its fault alarm, for example, a link up with a link down.

• Correlating a set of events into a single network failure, for example, multiple events of port down 
with a related module-out event.

• Correlating side-effect events with a single root-cause alarm across the network, for example, OSPF 
neighbor-down syslog message with a link-down alarm.
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• Correlating loss of reachability to a device with a network failure.

For more information about the definition of a ticket, alarm, and event, see Events, Tickets and Alarm 
Definitions, page 1-3.

For more information about alarms, refer to the Cisco Active Network Abstraction Fault Management 
User Guide.

For more specific information on tickets, including fault and IP correlation, MPLS-TE (Traffic 
Engineering), refer to the Cisco Active Network Abstraction Managing MPLS User Guide.

Alarm Life-Cycle
Cisco ANA NetworkVision correlates all the subalarms to the original parent alarm (root-cause alarm), 
and changes its status accordingly. 

Cisco ANA provides for an aging period before closing alarms. The alarm may remain open for 
correlation even if it has already been cleared or acknowledged. In other words, for a specified aging 
period, new correlated alarms are accepted into a parent alarm even after the parent alarm has been 
cleared or acknowledged.

An alarm is considered closed after the parent alarm has been cleared and the aging period has passed 
even if the parent alarm still contains open correlated alarms. 

Accumulating Affected Parties
When a fault occurs, Cisco ANA automatically calculates the affected parties (automatic impact 
analysis), for example, when a link goes down and embeds this information in the ticket along with all 
the correlated faults. You can view a list of all the inter-site connections that are affected and the sites 
that have lost connectivity. For more information about proactive impact analysis, see Viewing Impact 
Analysis, page 7-4.

The Affected Parties tab displays the services (affected pairs) that are potentially affected (automatic 
impact analysis) by the ticket. For more information about the Affected Parties tab, see Affected Parties 
Tab, page 8-8.

In the example below the following types of alarms exist in the correlation tree:

• Ticket root-cause alarm (card out).

• An alarm which is correlated to the root cause and has other alarms correlated to it (link A down).

• An alarm with no other alarms correlated to it (link B down and BGP neighbor loss).

An event sequence is correlated to each of these alarms.

Figure 8-1 Event Sequence Example

Card out
|
----- Link A down 

|    |
|    ------BGP neighbor loss 
|
----- Link B down 

Card out
|
----- Link A down 

|    |
|    ------BGP neighbor loss 
|
----- Link B down 

18
01
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For each type of alarm Cisco ANA NetworkVision provides a report of the affected parties. This report 
includes the accumulation of:

• The affected parties reported on all the events in the alarm event sequence (this also applies to 
flapping alarms).

• The affected parties reported on the alarms that are correlated to it.

Each report includes the accumulation of the affected report of all the events in its own correlation tree.

For example, in the diagram:

• “BGP neighbor loss” includes the accumulation of the affected report of its own event sequence.

• “Link A down” includes the accumulation of the report of its own event sequence. In addition, it 
includes the report of the BGP neighbor loss.

Accumulating the Affected Parties in an Alarm

When there are two events that form part of the same event sequence in a specific alarm the reoccurring 
affected pairs are only displayed once in the Affected Parties tab. Where there are different affected 
severities reported for the same pair, the pair is marked with the severity that was reported by the latest 
event, according to the time stamp.

Accumulating the Affected Parties in the Correlation Tree

Where there are two or more alarms:

• That are part of the same correlation tree,

• That report on the same affected pair of edge points and,

• That have different affected severities.

Then the reoccurring affected pairs are only displayed once in the Affected Parties tab. Where there are 
different affected severities reported for the same pair, the pair is marked with the highest severity.

In this example X and Y are the OIDs of edge points in the network and there is a service running 
between them. Both of the alarms “Link B down” and “BGP neighbor loss” report on the pair “X<->Y” 
as affected:

• “Link B down” reports on “X<->Y” as “Potentially” affected.

• “BGP neighbor loss” reports on “X<->Y” as “Real” affected.

The affected severity priorities are:

• Real – Priority 1

• Recovered – Priority 2

• Potentially – Priority 3

“Card out” reports on “X<->Y” as “Real” affected only once.

Updating Affected Severity Over Time

Cisco ANA has the ability to update the affected severity of the same alarm (report) over time due to the 
fact that in some cases the affect of the fault on the network cannot be determined until the network has 
converged. 
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For example, a link-down alarm creates a series of affected severity updates over time. These updates 
are added to the previous updates in the system database. In this case the system provides the following 
reports:

• The first report of a link down reports on “X<->Y” as Potentially affected. 

• Over time the VNE identifies that this service is Real affected or Recovered and generates an 
updated report. 

• The Affected Parties tab of the Ticket Properties dialog box displays the latest severity which is Real 
affected. 

• The Affected Parties Destination Properties dialog box displays both reported severities.

This functionality is currently only supported for link down.

Filtering Tickets by Device
Cisco ANA NetworkVision enables you to filter the tickets that are shown in the ticket pane so that only 
the tickets of a selected device or network element are displayed.

To filter tickets for a specific network element:

Step 1 Right-click on the required device or network element in the tree pane or map pane of the Cisco ANA 
NetworkVision window to display the Device shortcut menu.

Step 2 Select Filter Tickets. The ticket pane displays the tickets of the selected device or network element only.

Note The Filter button in the ticket pane toggles to indicate that a filter has been applied.

The filter can be removed to display all the tickets in the system. For more information about removing 
a filter, see Filtering Tickets by Criteria, page 8-4.

Filtering Tickets by Criteria
Cisco ANA NetworkVision enables you to define a filter for the tickets displayed in the ticket pane 
according to various criteria; for example, tickets can be filtered according to the number of affected 
parties or acknowledged tickets.

To define the ticket filter:

Step 1 On the toolbar of the ticket pane, click Ticket Filter. The Ticket Filter dialog box is displayed.
8-4
Cisco Active Network Abstraction NetworkVision User Guide, Version 3.6

OL-12500-01



 

Chapter 8      Working with Tickets
    Filtering Tickets by Criteria
Figure 8-2 Ticket Filter Dialog Box

The Severity area in the Ticket Filter dialog box enables the user to filter the tickets displayed in the 
ticket pane by selecting one or more options. For more information about severities, see Status of 
Network Objects, page 2-15.

The checkboxes displayed in the Other area reflect the columns displayed in the ticket pane and enable 
the user to filter the tickets according to any of these criteria. For more information about the columns 
displayed in the ticket pane, see Ticket Pane, page 2-13.

The Source checkbox (selected by default) enables the user to filter the tickets that are shown in the ticket 
pane so that only the tickets of a selected device or network element are displayed by selecting a source.

Step 2 Select the required filter values.

Step 3 Click OK. The filtered tickets are displayed in the ticket pane according to the defined criteria.

Note The Ticket Filter button in the ticket pane toggles to indicate that a filter has been applied.

To remove the ticket filter:

Step 1 On the toolbar of the ticket pane, click Ticket Filter. The Ticket Filter dialog box is displayed. 

Step 2 Click Clear. The selected options in the Ticket Filter dialog box are cleared.

Step 3 Click OK. All the tickets are displayed in the ticket pane.
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Opening Ticket Properties
The properties of a selected ticket can be viewed by displaying the Ticket Properties dialog box. For 
example, you can view alarm severity, correlated alarms, active alarms, alarm history or the source of 
the alarm.

To open ticket properties:

Step 1 Double-click on the required ticket in the ticket pane.

or

Right-click on a ticket in the ticket pane to display the Ticket shortcut menu, select Properties. 

The Ticket Properties dialog box is displayed.

Figure 8-3 Ticket Properties Dialog Box

The information displayed in the Ticket Properties dialog box corresponds with the information 
displayed in the ticket pane. The ID number displayed in the header corresponds to the ID number of the 
ticket selected in the ticket pane.

The Ticket Properties dialog box is divided into the following areas:

• Tabbed Pane

• Toolbar
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Tabbed Pane
The Ticket Properties dialog box is divided into the following tabs:

• General—General information about the selected ticket, see General Tab, page 8-7.

• History—The history of the ticket, see History Tab, page 8-7.

• Affected Parties—The services (affected pairs) that are potentially affected (potential impact 
analysis) by the ticket, see Affected Parties Tab, page 8-8.

• Correlation—All the alarms that are correlated to the selected ticket, see 
Correlation Tab, page 8-10.

• Notes—Enables you to add notes to the selected ticket, see Notes Tab, page 8-11.

• Advanced—All the affected devices, correlation, duplication and reduction counts for the selected 
ticket. In addition, it provides any other additional information available about the ticket, see 
Advanced Tab, page 8-11.

General Tab

The following fields are displayed in the General tab providing information about the compiled alarm:

• Alarm—The supported root-cause alarm name, for example, link down.

• Location—The entity that triggered the root-cause alarm, as a hyperlink that opens the relevant 
location.

• Severity—Displays the severity that was propagated from all the correlated alarms. For more 
information, see Map Pane, page 2-7.

• Time—The date and time when the initial root-cause alarm was generated. The time is taken from 
Cisco ANA.

• Open Alarms—The number of correlated alarms for the ticket that are open. For example, 3 / 4. 
Four relates to the total number of correlated alarms for the ticket. Three indicates the number of 
alarms that have not been cleared, and therefore there is one alarm that is cleared.

• Acknowledged—The status of the ticket that is being handled, namely, acknowledged (true) and 
unacknowledged (false).

• Description—The detailed description from the ticket.
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History Tab

The History tab enables you to display the history of the ticket, including all the events. The History tab 
is displayed.

Figure 8-4 History Tab

The following columns are displayed in the History tab providing information about the compiled alarm:

• Severity—Displays a severity bell icon, which is colored according to the severity of the alarm.

• Alarm ID—The ID number of the event that changed the ticket.

• Duplication Count—The number of occurrences of the root alarm in a successors sequence. For 
example, link down, link up, link down would equal a duplication counter of 2.

• Short Description—A description of the event.

• Reduction Count—The number of alarms displayed under the ticket. For example, nine alarms may 
be viewed in the History tab accessed from the NetworkVision ticket pane, whereas, only a single 
ticket is displayed in the ticket pane.

• Location—The entity that triggered the alarm, as a hyperlink that opens the relevant location.

• Time—The date and time when the ticket changed.
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Affected Parties Tab

When a fault occurs Cisco ANA automatically calculates the affected parties (automatic impact 
analysis), for example, when a link goes down, and embeds this information in the ticket along with all 
the correlated faults. You can view a list of all the endpoints that are affected. For more information about 
proactive impact analysis, see Viewing Impact Analysis, page 7-4.

The Affected Parties tab displays the service resources (affected pairs) that are affected (automatic 
impact analysis) by the ticket. For more information about accumulating affected parties, see 
Accumulating Affected Parties, page 8-2.

The Affected Parties tab is displayed.

Figure 8-5 Affected Parties Tab

The Affected Parties tab is divided into two areas, namely, Source and Destination. The Source area 
displays the set of affected elements (A side and Z side). The following columns are displayed in the 
Affected Parties tab providing information about the affected parties:

• Location—A hyperlink that opens the Inventory window, highlighting the port with the affected 
parties.

• Key—The unique value taken from the affected element’s business tag key (if it exists).

• Name—The subinterface (site) name or business tag name of the affected element (if it exists). For 
more information refer to the Cisco Active Network Abstraction Managing MPLS User Guide.

• Type—The business tag type.
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• IP Address—If the affected element is an IP interface the IP address of the subinterface (site) is 
displayed. For more information refer to the Cisco Active Network Abstraction Managing MPLS 
User Guide.

• Highest Affected Severity—The severest affected severity for the affected pair (Destination). The 
same source can be part of multiple pairs, and therefore each pair can have different affected 
severities. The highest affected severity reflects the highest one among these. The affected pair can 
have one of the following severities: 

– Potential—The service may be affected but its real state is not known.

– Real—The service is affected.

– Recovered—The service was recovered after the network fault. This state only applies to 
affected pairs that were previously marked as Potentially Affected or Real Affected.

– N/A—From Links view this indicates not relevant.

When an affected side (a row) is selected in the Source area the selected element’s related affected pairs 
are displayed in the Destination area. 

The following additional columns are displayed in the Destination area table in the Ticket Properties 
window:

• Affected Severity—The severity of the affected pair as calculated by the client according to the 
rules defined in Accumulating Affected Parties, page 8-2.

• Alarm Clear State—An indication for each pair of the clear state of the alarm. The following states 
exist:

– Not Cleared—There are one or more alarms that have not been cleared for this pair.

– Cleared—All the related alarms for this pair have been cleared.

In addition, you can view a detailed report for every affected pair that includes a list of the events that 
contributed to this affected pair. For more information about viewing a detailed report, see Viewing a 
Detailed Report for the Affected Pair, page 8-12.
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Correlation Tab

The Correlation tab displays all the alarms that are correlated to the selected ticket. 

Figure 8-6 Correlation Tab

Each branch provides a short description of the alarm, a severity icon, ID, location, and time of the alarm. 
For more information about the columns displayed in the Correlation tab, see Ticket Pane, page 2-13. 

The following columns are displayed in the Correlation tab providing information about the alarm as 
follows:

• ID—The ID number of the alarm. The branches can be expanded and collapsed in order to hide 
information as needed.

• Short Description—A description of the change in the ticket. The full description is displayed in 
the lower tab area.

• Location—A hyperlink that opens the Inventory window, selecting the node with the affected 
parties.

• Time—The date and time the alarm was issued.

• Last Modification Time—The date and time when the alarm changed.

• Reduction Count—The number of alarms displayed under the ticket. For example, nine alarms may 
be viewed in the History tab accessed from the NetworkVision ticket pane, whereas, only a single 
ticket is displayed in the ticket pane.

• Duplication Count—The number of occurrences of the root alarm in a successors sequence. For 
example, link down, link up, link down would equal a duplication counter of 2.

The Find field on the toolbar enables you to search for information in the Correlated Alarms table.
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Notes Tab

The Notes tab enables you to add and save notes for the selected ticket. The Notes tab is displayed below.

To add text, enter text in the Notes field and click Save Notes. The new text is added to any previously 
existing text.

Note • Save Notes is only enabled when text is entered in the Notes field.

• The text cannot be edited or removed once you have saved the notes.

Advanced Tab

The Advanced tab enables you to view all the affected devices, correlation, duplication and reduction 
counts for the selected ticket. In addition, it provides any other additional information available about 
the ticket. The Advanced tab is displayed below.

The following fields are displayed in the Advanced tab providing information about the compiled alarm:

• Successor—A hyperlink to the successor event (if it exists), for example, port up.

• Correlator—A hyperlink to the correlator alarm (if it exists).

• Predecessor—A hyperlink to the predecessor event (if it exists), for example, port down.

• Affected Devices—The number of devices affected by the ticket (the source(s) of the alarm and their 
subsequent alarms).

• Duplication Count—Displays the number of occurrences of the original root-cause alarm included 
in the ticket. For example, if the ticket was created by a link-down root-cause alarm, and then the 
link goes up and down again quickly so that it is included in the same ticket, then the duplication 
counter displays the number 2, as the root-cause alarm occurred twice.

• Correlation Count—Displays the number of correlated alarms included in the ticket. For example, 
if in the Correlation tab of the Ticket Properties, there are 3 alarms correlated to the root-cause 
alarm, then the counter displays the number 3. If there are 2 alarms correlated to the root-cause 
alarm, and each alarm in turn has 2 alarms correlated to it, then the counter displays the number 4.

• Reduction Count—Displays the number of alarms included in the ticket. For example, nine alarms 
can be viewed in the History tab of the Ticket Properties window, but only a single ticket is displayed 
in the ticket pane.
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Toolbar
The Ticket Properties dialog box contains the following tools:

Viewing a Detailed Report for the Affected Pair
Cisco ANA NetworkVision enables you to view a detailed report for every affected pair. The detailed 
report includes a list of the events that contributed to the affected pair. 

To open a detailed report:

Step 1 Open the Ticket Properties dialog box for the required ticket, see Opening Ticket Properties, page 8-6.

Step 2 Select the Affected Parties tab. The Affected Parties tab is displayed in the Ticket Properties dialog box.

Step 3 Select an affected side (a row) in the Source area table of the Ticket Properties dialog box. The selected 
element’s related affected pairs are displayed in the Destination area.

Step 4 Select one of the element’s affected pairs in the Destination area table of the Ticket Properties dialog 
box.

Step 5 Right-click to display the shortcut menu, and select Detailed Report, or double-click on the affected 
pair. The Affected Parties Destination Properties dialog box is displayed.

The following fields are displayed at the top of the Affected Parties Destination Properties dialog box: 

• Affected Pair—The details of A side and Z side of the affected pair.

• Alarm Clear State—An indication for each pair of the clear state of the alarm. The following states 
exist:

Refreshes the information displayed in the Ticket Properties dialog box.

 Acknowledge—Acknowledges that the ticket is being handled and the 
status of the ticket is displayed as true in the ticket pane and in the Ticket 
Properties dialog box. For more information, see Acknowledged Ticket, 
page 8-16.

If a ticket was acknowledged, and some events were correlated to it 
afterwards, then the ticket is considered to have been NOT 
acknowledged.

Note This button is only enabled if the ticket is not acknowledged.

 Clear—Requests the relevant Cisco ANA to remove the faulty network 
element from the Cisco ANA networking inventory. In addition, it sets 
the ticket to Cleared severity or status (the icon is displayed in green) 
and automatically changes the acknowledged status of the ticket to true. 
For more information, see Cleared Ticket, page 8-16.

Note This button is only enabled if the severity of the alarm is higher 
than Cleared or Normal.

 Save Notes—Saves the notes for the selected ticket.

Note This button is only enabled when text is entered in the Notes 
field of the Notes tab.
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– Not Cleared—There are one or more alarms that have not been cleared for this pair.

– Cleared—All the related alarms for this pair have been cleared.

• Affected Severity—The severity of the affected pair as calculated by the client according to the 
rules defined in Accumulating Affected Parties, page 8-2. 

• Name—The name of the destination from which you opened the detailed report.

Each row in the Instances table represents an event that was reported for the affected pair. The following 
columns are displayed in the Instances table of the Affected Parties Destination Properties dialog box:

• Alarm OID—The ID of the alarm to which the event is correlated as a hyperlink to the relevant 
alarm’s properties.

• Alarm Description—A description of the alarm to which the event is correlated.

• Alarm Clear State—The alarm’s calculated severity.

• Event OID—The ID of the event as a hyperlink to the relevant event’s properties.

• Event Description—A description of the event.

• Event Time Stamp—The event’s time stamp. The date and time of the event.

• Affected Severity—The actual affected severity of the pair that was reported by the selected event. 
For more information, see Affected Parties Tab, page 8-8.

Step 6 Click  to close the Affected Parties Destination Properties dialog box. The Ticket Properties dialog 
box is displayed.

Acknowledging a Ticket 
When an alarm occurs, a warning or ticket is displayed in the ticket pane. Cisco ANA NetworkVision 
enables you to handle the status of a ticket by acknowledging it. This acknowledges the fault. 

The change is reported to the Cisco ANA Gateway and all open Cisco ANA NetworkVision applications. 
Several tickets can be acknowledged at the same time. For more information, see Ticket Status in the 
Ticket Pane, page 8-15.

Note Rule-based alarms can be configured per customer site or upon request.

An acknowledged ticket will change back to not acknowledged when a new event is correlated to it. You 
cannot undo this operation. To acknowledge a ticket:

Step 1 Right-click on a ticket in the ticket pane. The Ticket shortcut menu is displayed.

Step 2 From the Ticket shortcut menu, select Acknowledge. 

or

Click Acknowledge in the Ticket Properties dialog box. 

The ticket is handled as described above.
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Clearing a Ticket
When an alarm occurs a warning or ticket is displayed in the ticket pane. Cisco ANA NetworkVision 
enables you to handle the reported ticket by verifying the report of what is faulty and clearing the faulty 
network element. The change is reported to the Cisco ANA Gateway and all open Cisco ANA 
NetworkVision applications. This operation cannot be reversed.

Clearing an open ticket performs the following operations:

• Sends a request to the Cisco ANA system to remove the faulty network element from the Cisco ANA 
networking inventory.

• Sets the alarm to Cleared or Normal severity or status by issuing a corresponding Clear alarm.

• Automatically sets the alarm severity or status to acknowledged (true).

Note When a Card Out or link-down alarm occurs the relevant information is displayed in the inventory and 
maintained in the VNE.

To clear a ticket:

Step 1 Right-click on a ticket in the ticket pane. The Ticket shortcut menu is displayed.

Step 2 From the Ticket shortcut menu, select Clear. 

or

Click Clear in the Ticket Properties dialog box.

The ticket is handled as described above. 

For more information, see Ticket Status in the Ticket Pane, page 8-15.

Removing a Ticket 
When an alarm occurs a warning or ticket is displayed in the ticket pane. Cisco ANA NetworkVision 
enables you to completely remove the ticket and all its active alarms and business tags. The change is 
reported to the Cisco ANA Gateway and all open Cisco ANA NetworkVision applications. In addition, 
several tickets can be removed at the same time. When a ticket has been cleared or when an ‘Up Alarm’ 
occurs then the ticket can be removed. This operation cannot be reversed. A ticket that has been removed 
can only be viewed using Cisco ANA EventVision.

Removing an alarm performs the following operations:

• Sends a request to the Cisco ANA system to remove the faulty network element from the Cisco ANA 
networking inventory.

• Archives the ticket, and active alarms.

• Removes the ticket from the Cisco ANA NetworkVision ticket pane.

• Notifies all the open Cisco ANA NetworkVision applications of the removal.

Note Only tickets with a Cleared/Normal or Information severity can be removed.
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To remove a ticket:

Step 1 Right-click on a ticket in the ticket pane. The Ticket shortcut menu is displayed.

Step 2 From the Ticket shortcut menu, select Remove. 

The ticket is handled as described above.

For more information, see Ticket Status in the Ticket Pane, page 8-15.

In addition, an uncleared ticket (which has a severity higher than Cleared or Normal) can be cleared and 
removed by right-clicking in the ticket pane and selecting Clear and Remove. For more information 
about the Ticket shortcut menu, see Ticket Shortcut Menu, page 2-30.

Ticket Status in the Ticket Pane
The appearance of a ticket displayed in the ticket pane depends on the status or severity of the (ticket) 
alarm and what affect manipulating the ticket has on the way in which the ticket is displayed in the ticket 
pane.

Tickets detailed in the ticket pane change when a:

• Ticket is generated.

• Ticket is cleared.

• Ticket is acknowledged.

• ‘Up Ticket’ is generated.

• Ticket is cleared and removed.

• Ticket is removed.

• Some other properties are updated, for example, severity, description, counters and so on.

Generated Ticket 
An example of the appearance of the ticket pane when a ticket is generated is displayed.

Table 8-1 Generated Ticket

Severity Ticket ID Short Description Acknowledged

 Major 27 Port down False (Not Acknowledged)
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Cleared Ticket 
An example of the appearance of the ticket pane when a ticket is cleared is displayed.

A ticket that has been cleared can then be removed from the ticket pane. For more information, see 
Removing a Ticket, page 8-14.

When a ticket is cleared, its definition changes to acknowledged automatically in the ticket pane and its 
definition in the Acknowledged column is True.

Acknowledged Ticket 
An example of the appearance of the ticket pane when a ticket is acknowledged is displayed below. When 
a ticket is acknowledged it can then be cleared and the severity changes to Normal.

Note When a ticket with an Information severity is acknowledged, the ticket is automatically removed from 
the Cisco ANA Gateway and from the ticket pane.

Generated Up Ticket 
The cause of the alarm is fixed; therefore an ‘Up Ticket’ is automatically generated with a Normal 
severity. An example of the appearance of the ticket pane when an ‘Up Ticket’ is generated is displayed.

Clearing and Removing Tickets
Approves the reported faulty ticket and clears the faulty networking entity from Cisco ANA. 

Table 8-2 Cleared Ticket

Severity Ticket ID Short Description Acknowledged

 Normal 27 Cleared due to Force Clear True (Acknowledged)

Table 8-3 Acknowledged Ticket

Severity Ticket ID Short Description Acknowledged

 Major 27 Port up True

Table 8-4 Generated Up Ticket

Severity Ticket ID Short Description Acknowledged

 Normal 27 Port up True
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C H A P T E R 9

Working with Cisco ANA PathTracer

This chapter describes how to view a network path between two network objects using Cisco ANA 
PathTracer:

• In a circuit-switched network, like Frame Relay or ATM, or

• In packet-switched networks, like Ethernet and IP. 

In addition, it describes the Cisco ANA PathTracer working environment and the functionality available 
when using Cisco ANA PathTracer.

• Overview, page 9-1, describes the Cisco ANA PathTracer single and multi-path route tracing 
functionality and the information that can be viewed in the two main Cisco ANA PathTracer 
windows.

• Opening Cisco ANA PathTracer, page 9-2, describes how to open Cisco ANA PathTracer.

• Cisco ANA PathTracer Multi-Path Window, page 9-4, describes the Cisco ANA PathTracer 
multi-path window working environment and the information that can be viewed.

• Cisco ANA PathTracer Single-Path Window, page 9-7, describes the Cisco ANA PathTracer 
single-path window working environment and the information that can be viewed.

• Viewing Path Information, page 9-12, describes how to view information about the path between 
two network objects, including ingress and egress port information.

• Saving and Opening Cisco ANA PathTracer Map Files, page 9-13, describes how to export the maps 
(paths) displayed in the Cisco ANA PathTracer multi-path window to an .xml file.

• Saving Cisco ANA PathTracer Counter Values, page 9-13, describes how to export the counter 
values of the path displayed in the Cisco ANA PathTracer single-path window to a .csv file.

• Rerunning a Path and Making a Comparison, page 9-14, describes how to rerun a path using a 
previously saved map file with the same source and destination and then compare the paths.

Overview
Cisco ANA PathTracer enables end-to-end route tracing to be performed with informative performance 
information displayed simultaneously for the multiple networking layers. Upon receiving a path's start 
and endpoint, Cisco ANA PathTracer visually traces the route through the network. For example, in an 
ATM network environment, Cisco ANA PathTracer identifies all information regarding the connection 
of a subscriber to a provider, including all ATM PVCs, ATM switching table, ATM class of services, IP 
related information and so on.
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Cisco ANA understands and is able to derive the various paths on the network due to the up-to-date 
knowledge of the network. Cisco ANA PathTracer finds and retrieves the path of a specified service, 
after the user has selected a source and destination. The retrieved information contains, for example, all 
the network elements in path. 

Cisco ANA PathTracer enables the user to view multiple paths between the source and the destination 
in the Cisco ANA PathTracer multi-path window, or to view a selected single-path in the Cisco ANA 
PathTracer single-path window.

Opening Cisco ANA PathTracer
Cisco ANA PathTracer can be opened from an ATM VC, DLCI, or from an IP interface entry point. The 
virtual route is found according to the Cross Connect table of each ATM switch or Frame Relay device. 
The IP routing and path finding process is enabled according to the Routing VRF tables of each router.

In order to view a specific path you must specify an initial point like VPI/VCI, DLCI, Ethernet port or 
IP interface and a destination IP address (optional). If the user specified VC information or DLCI 
information, which ends in a router, Cisco ANA PathTracer finds the next hop according to the 
“destination IP address”. If the user did not specify the destination IP address the system uses the default 
gateway in the router. In addition, the related business tags that have been referred to the physical or 
logical entities are also displayed.

Note The path can also be opened if there is a business tag attached to an endpoint that can be used as the 
starting point for opening the Cisco ANA PathTracer.

The Cisco ANA PathTracer tool provides the user with two windows in which to view the path:

• Cisco ANA PathTracer Multi-Path Window—Displays all the paths available between the selected 
source and destination.

• Cisco ANA PathTracer Single-Path Window—Displays a single path available between the selected 
source and destination, as well as, the subscribers and properties.

The user can also enter the required destination IP address after opening the Cisco ANA PathTracer from 
the right-click shortcut menu at one of the following locations:

Element Location

Affected Parties • Inventory window

• Ticket Properties window (Affected Parties tab)

VC Cross Connect Table • Inventory window (Cross Connect dialog box)

Site • Service View map

IP Interface • Inventory window

• Affected entry

Layer 2 MPLS Tunnel • Inventory window

VC Table • Inventory window (VC Table dialog box)

Business tag • The path can be found using a business tag, which is attached to 
the VPI/VCI, or IP interface by entering its key, and it can then be 
opened from the Find Business Tag window.
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To open Cisco ANA PathTracer:

Step 1 Double-click on a device/element in the tree pane or map pane of the Cisco ANA NetworkVision 
window’s workspace,

or

Right-click on a device/element in the tree pane or map pane of the Cisco ANA NetworkVision window’s 
workspace to display the Device shortcut menu. Select Inventory.

The Inventory window is displayed.

Step 2 In the Physical Inventory branch of the tree pane, drill down and select the required port. 

Step 3 Right-click on the required port to display the shortcut menu and select PathTracer | From Here to IP 
Destination.

or

Open the Logical Inventory’s Routing Entity properties pane, right-click on the required element in the 
IP Interface tab, and select PathTracer | Start Here and PathTracer | End Here from the shortcut 
menu.

Note The “End Here” option indicates that when a certain point is selected as “End Here” the system 
extracts the relevant IP address from this point and uses it as the destination.

The Path Information dialog box is displayed.

Step 4 Enter the required destination IP address.

Step 5 Click OK. The Cisco ANA PathTracer multi-path window is displayed 

For more information about this window, see Cisco ANA PathTracer Multi-Path Window, page 9-4.

Step 6 In the Cisco ANA PathTracer multi-path window, select a path in the Paths pane.

Note If multiple paths are selected in the Paths pane they will be opened. If nothing is selected in the 
Paths pane, then all the available paths will be opened automatically, and each one will be 
displayed in a separate Cisco ANA PathTracer single-path window.

Step 7 On the toolbar, click Cisco ANA PathTracer. The Cisco ANA PathTracer single-path window is 
displayed showing the end-to-end path. 

For more information about this window, see Cisco ANA PathTracer Single-Path Window, page 9-7.

For more information about opening the Cisco ANA PathTracer from other Cisco ANA NetworkVision 
windows, and selecting multi-path options, refer to the section on Viewing Multi-Path Routes in VPN 
Networks in the Cisco Active Network Abstraction Managing MPLS User Guide.

Ethernet port • Inventory window

MPLS-TE Tunnel • Inventory window

Element Location
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Cisco ANA PathTracer Multi-Path Window 
The Cisco ANA PathTracer multi-path window displays all the discovered paths for the selected context, 
including devices, and physical links. 

The Cisco ANA PathTracer multi-path window enables you to perform the following functions:

• View a previous path or view the next path.

• Open the Cisco ANA PathTracer single-path window in order to view a single selected path.

• Save the multi-path map to a file.

• Run the Cisco ANA PathTracer again.

An example of the Cisco ANA PathTracer multi-path window is displayed below.

Figure 9-1 Cisco ANA PathTracer Multi-Path Window

The Cisco ANA PathTracer multi-path window is divided into the following areas:

• Cisco ANA PathTracer Multi-Path Window Toolbar

• Cisco ANA PathTracer Multi-Path Window Menus

1 Menu bar

2 Toolbar

3 Map path traced at...tabs

4 Paths pane

5 Status bar

6 Map pane
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• Tabs

• Paths Pane

• Map Pane

Cisco ANA PathTracer Multi-Path Window Toolbar
The Cisco ANA PathTracer multi-path window contains the following tools:

For information about the selection tools displayed on the toolbar, see Cisco ANA NetworkVision 
Toolbar, page 2-18.

Cisco ANA PathTracer Multi-Path Window Menus
This section provides a description of each option available in the Cisco ANA PathTracer multi-path 
window menus. The following menus are available:

• File Menu

• View Menu

• Shortcut Menu

Button Function

Selects the previous path viewed in the topological map pane.

Selects the next path viewed in the topological map pane.

Clears the path selection made in the topological map pane.

Opens the Cisco ANA PathTracer single-path window based on the path 
selected in the Cisco ANA PathTracer multi-path window. A map is displayed 
for the selected path, including NE details, links and property information. For 
more information, see Cisco ANA PathTracer Single-Path Window, page 9-7.

Saves the multi-path map displayed in the topological map pane. For more 
information, see Saving and Opening Cisco ANA PathTracer Map Files, 
page 9-13.

Defines the way in which the map is displayed in the topological map pane, 
namely, Circular, Symmetric, Tree, or Hierarchical.

Opens a window displaying an overview of the network displayed in the 
topological map pane.

Runs Cisco ANA PathTracer again creating a new map that is displayed in 
topological map pane tab. A new tab with an up-to-date (refreshed) path map 
is created for each run (the source and destination must be the same), with 
each tab representing a run, and its header indicating the snapshot time.
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File Menu

The Cisco ANA PathTracer multi-path window File menu is displayed with the following options.

Run Again

Runs the PathTracer again, using the same source and destination parameters.

Save

Save the map displayed in the Cisco ANA PathTracer multi-path window. For more information, see 
Saving and Opening Cisco ANA PathTracer Map Files, page 9-13.

Close

Closes the open Cisco ANA PathTracer multi-path window.

Shortcut Menu

The shortcut menu displayed in the Cisco ANA PathTracer multi-path window is context sensitive 
depending on the view and the NE selected. The Device shortcut menu is displayed when right-clicking 
on a NE.

For more information about the Device shortcut menu and for a detailed description of all the menu 
options available here, see Device Shortcut Menu, page 2-25.

Tabs
The path is initially displayed in the map pane in a tab that displays the starting point date and time of 
when Cisco ANA commenced the path tracing process (snapshot time). 

If you want to load a saved path from a file or run the displayed path again, a new tab with an up-to-date 
(refreshed) path map is created for each run or file (the source and destination must be the same). This 
is displayed in a separate tab, with each tab representing a run or file, and its header indicating the 
snapshot time.

Paths Pane
The Paths pane displays all the paths available for the selected source and destination (for each pair of 
source and destination a new path is created). The paths are displayed using numbers. Selecting a path 
in the Paths pane enables you to view each individual path in the map pane of the Cisco ANA PathTracer 
single-path window and the selected path is highlighted in the map pane.

Map Pane
The map pane enables you to view a route map of the intermediate network elements. The map displays 
devices, links and paths (topological paths).
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Icons are used in the map pane to display the network objects and these icons provide a visual 
representation of the network object’s status. For more information about the icons used, see 
Appendix A, “Icon Reference”.

Every link and node are labeled with the relevant paths numbers. The starting point is labeled with a 
special Starting Point label. All other edge points are displayed as clouds.

Cisco ANA PathTracer Single-Path Window 
The Cisco ANA PathTracer single-path window displays the devices and links of the discovered path, as 
well as path layer properties information in tables and subscribers. 

Note This section refers to single-path view only.

The Cisco ANA PathTracer single-path window enables you to:

• View a map of the intermediate network elements.

• View the following information for each network element:

– The relevant parameters for each interface on all layers along the path.

– For each layer an indication of a mismatch between the parameters of the interfaces on both 
sides of a link.

– View traffic statistics along the path.

• Monitor the status and traffic of all the links along the path.

• View In and Out port properties. 

In addition, right-clicking on an item in Cisco ANA PathTracer enables you to perform certain functions. 
For example, you can view device information, including device properties, and attach business tags.
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An example of the Cisco ANA PathTracer single-path window is displayed.

Figure 9-2 Cisco ANA PathTracer Single-Path Window

The Cisco ANA PathTracer single-path window is divided into the following areas:

• Cisco ANA PathTracer Single-Path Window Toolbar

• Cisco ANA PathTracer Single-Path Window Menus

• Topological Map

• Properties Table and Layer Tabs

1 Menu bar

2 Toolbar

3 Map pane

4 Hide/Display Properties table

5 Properties table

6 Layer tabs

7 Status bar
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Cisco ANA PathTracer Single-Path Window Toolbar
The Cisco ANA PathTracer single-path window contains the following tools:

Cisco ANA PathTracer Single-Path Window Menus
This section provides a description of each option available in the Cisco ANA PathTracer single-path 
window menus:

• File Menu

• View Menu

• Tools Menu

• Help Menu

• Shortcut Menu

File Menu

The Cisco ANA PathTracer single-path window File menu is displayed with the following option:

Close

Closes the open Cisco ANA PathTracer single-path window.

View Menu

The Cisco ANA PathTracer single-path window View menu is displayed with the following options:

Show All

Displays all the information in the Properties Table tabs.

Table 9-1 Cisco ANA PathTracer Single-Path Window Tools

Button Function

Displays all the information in the tabs.

Hides all the information in the tabs.

Exports the currently displayed data to a CSV file.

Starts exporting the counter values of the path displayed in the Cisco ANA 
PathTracer single-path window to a CSV file.

Stops exporting the counter values of the path displayed in the Cisco ANA 
PathTracer single-path window to a CSV file.
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Hide All

Hides all the information in the Properties Table tabs.

Tools Menu

The Cisco ANA PathTracer single-path window Tools menu is displayed with the following options:

Note This section refers to single-path view only.

Export to File

Exports the currently displayed data to a file.

Start Saving to File

Starts exporting the counter values of the path displayed in the Cisco ANA PathTracer single-path 
window to a CSV file.

Stop Saving to File

Stops exporting the counter values of the path displayed in the Cisco ANA PathTracer single-path 
window to a CSV file.

Help Menu

The Cisco ANA PathTracer single-path window Help menu is displayed with the following options:

Help Contents

Opens the Cisco ANA NetworkVision online help.

Help About

Displays application information, for example, the version number.

Shortcut Menu

The shortcut menu displayed in the Cisco ANA PathTracer single-path window is context sensitive 
depending on the view and the NE selected. The Device shortcut menu is displayed when right-clicking 
on a NE, as displayed.

For more information about the Device shortcut menu and for a detailed description of all the menu 
options available here, see Device Shortcut Menu, page 2-25.

Show ‘In’ Port

Highlights information regarding the In Port (the in port of the device in the path)of the selected network 
element in the Properties table of the Cisco ANA PathTracer single-path window.
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Note This option is only available in the Device shortcut menu in the Cisco ANA PathTracer single-path 
window.

Show ‘Out’ Port

Highlights information regarding the Out Port (the out port of the device in the path) of the selected 
network element in the Properties table of the Cisco ANA PathTracer single-path window.

Note This option is only available in the Device shortcut menu in the Cisco ANA PathTracer single-path 
windows.

Topological Map

The topological map displays the devices and links that are part of the path. Icons are used in Cisco ANA 
PathTracer to display the network objects and these icons provide a visual representation of the network 
object’s status. For more information about the icons used, see Appendix A, “Icon Reference”.

For more information about the colors used to indicate severities, see Map Pane, page 2-7.

The same coloring conventions that are used in the map pane of the Cisco ANA NetworkVision window 
are used to display links in the Cisco ANA PathTracer single-path window. Selecting a device or link on 
the map automatically highlights the related parameters in the table.

Note The color of a selected link is customizable. The default color is blue.

There are three ways in which the status of a network object is indicated on the topological map:

1. By severity

2. By management state

3. By new alarms 

For more information, see Status of Network Objects, page 2-15.

Properties Table and Layer Tabs

The Properties Table and tabs displays the supported parameters of the specified NE. The Cisco ANA 
PathTracer single-path window is divided into tabs as shown in the example in the Cisco ANA 
PathTracer Single-Path Window, page 9-7.

The information parameters are displayed in a table, with the ingress and egress ports on the top and the 
parameters on the left.

Any inconsistencies between the two connected ports are colored to emphasize a discrepancy, for 
example, different admin statuses.

The Cisco ANA PathTracer information parameters are arranged in groups as follows:

• Networking Layers—This group displays information regarding each network element including 
ingress and egress port information. The information is either plain data that was extracted from the 
device or calculated data such as rates or statistics. This information is displayed in the Layer 1, 
Layer 2 and Layer 3 tabs.
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• Business—This area displays the name and the key of the business tags that have been attached to 
the network entities displayed, namely, the port or the entire device (physical entity), VC, VP, DLCI, 
context (logical entity) or MPLS. This information is displayed in the Business Tag area.

The Cisco ANA PathTracer window is divided into the following tabs and all appear empty when the 
window opens:

• Layer 1—Displays the Layer 1 information in the selected path and enables you to view the link 
parameters. The name of each device is displayed, as well as, the sub-slot, slot and port details. 

• Layer 2—Displays the Layer 2 information in the selected path. In addition, it enables you to view 
the link and connection parameters. For each of the devices, the name and MAC address is 
displayed, the VPI/VCI in an ATM link, or DLCI in a Frame Relay link. By default, the Cisco ANA 
PathTracer single-path window is displayed with the Layer 2 tab active. 

• Layer 3—Displays the Layer 3 information selected path and enables you to view the link 
parameters. The name of each device is displayed.

• Business Parameter—Displays the name and the key of the business tags that have been attached 
to the network entities displayed, namely, the port or the entire device (physical entity), VC, VP, 
DLCI, IP interface or context (logical entity).

For specific information about VPN Cisco ANA PathTracer information refer to the section on Viewing 
VPN Cisco ANA PathTracer Information in the Cisco Active Network Abstraction Managing MPLS User 
Guide.

Viewing Path Information 
The Cisco ANA PathTracer tabs display information regarding each network element including ingress 
and egress port information. The information is either plain data that was extracted from the device or 
calculated data such as rates or statistics. This information is displayed in the Layer 1, Layer 2 and 
Layer 3 tabs of the Cisco ANA PathTracer single-path window. 

To view path information:

Step 1 Select the required tab, and click Show All. The path information is displayed in the active tab of the 
Cisco ANA PathTracer single-path window.

Note Selecting a device or link on the map automatically highlights the related parameters in the table.

Note Drag the scroll bar at the bottom of the Cisco ANA PathTracer window to view the various areas of the 
selected path and the parameters.
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Saving and Opening Cisco ANA PathTracer Map Files
Cisco ANA NetworkVision enables you to export the maps (paths) displayed in the Cisco ANA 
PathTracer multi-path window to an .xml file. The data can then be viewed at a later stage in order to 
assess whether anything has changed.

To save Cisco ANA PathTracer Map Files:

Step 1 Open the Cisco ANA PathTracer multi-path window.

Step 2 On the toolbar, click Save,

or

Select Save from the File menu.

The Save dialog box is displayed.

Step 3 Browse to the directory where you want to save the file.

Step 4 In the File name field enter a name for the map file.

Step 5 Click Save. The map file is saved in the selected directory.

Cisco ANA NetworkVision enables you to open saved xml format path-tracing maps.

Note • When the user loads a multi-path file, Cisco ANA queries the file (not the network), and loads all 
the persisted information. 

• When the user loads a multi-path file that does not contain the same “start here” and “end here” 
destination information, the map is automatically opened in another instance of Cisco’s PathTracer.

To open Cisco ANA PathTracer Map Files:

Step 1 Select Load PathTracer from the File menu in the Cisco ANA NetworkVision window. The Open 
dialog box is displayed.

Step 2 Browse to the directory of the saved file and select the file.

Step 3 Click Open. The Cisco ANA PathTracer multi-path window is displayed with the previously saved map 
file.

Saving Cisco ANA PathTracer Counter Values 
Cisco ANA NetworkVision enables you to export the counter values of the path displayed in the 
Cisco ANA PathTracer single-path window to a CSV file. The data can then be viewed at a later stage.

Note This section refers to single-path view only.
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To save Cisco ANA PathTracer counter values:

Step 1 Open the Cisco ANA PathTracer window, see Opening Cisco ANA PathTracer, page 9-2.

Step 2 On the toolbar, click Start Saving to File,

or

Select Start Saving to File from the Tools menu. The Export Table to File dialog box is displayed.

Step 3 Browse to the directory where you want to save the Cisco ANA PathTracer counter values. 

Step 4 In the File name field enter a name for the Cisco ANA PathTracer counter values.

Step 5 Click Save. The Cisco ANA PathTracer counter values are saved in the selected directory.

The user can then stop exporting the counter values of the path displayed in the Cisco ANA PathTracer 
single-path window to a CSV file.

To stop saving Cisco ANA PathTracer counter values:

Step 1 On the toolbar, click Stop Saving to File,

or

Select Stop Saving to File from the Tools menu. 

Cisco ANA NetworkVision stops exporting the counter values to the CSV file.

Rerunning a Path and Making a Comparison
Cisco ANA NetworkVision enables you to save and load a path (see Saving and Opening Cisco ANA 
PathTracer Map Files, page 9-13). This file can then be used at a later stage rerun the path automatically 
using the same source and destination. You can then compare the paths for example, if you suspect that 
the path has changed and assess where the problem is occurring.

To rerun the path:

Step 1 Load the required map file, see Saving and Opening Cisco ANA PathTracer Map Files, page 9-13. The 
Cisco ANA PathTracer multi-path window is displayed with the previously saved map file.

Step 2 On the toolbar click Run Again,

or

Select Run Again from the File menu.

The path reruns automatically using the same source and destination as the loaded map file and a new 
tab is displayed in the Cisco ANA PathTracer multi-path window with the updated map (path). The tab 
also displays the updated details of the date and time when the path was rerun.

The user can easily compare the two paths by simply switching between the tabs in the Cisco ANA 
PathTracer multi-path window and comparing the old map (path) with the new updated one.
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Note • When the user loads a Cisco ANA PathTracer map file that does not contain the same source and 
destination information as the map that is currently displayed in the window, the map is 
automatically opened in another instance of the Cisco ANA PathTracer multi-path window.

• If the user loads a Cisco ANA PathTracer map file that contains the same source and destination 
information as a window which has already been opened, the file will be loaded in a new tab within 
this window.
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Working with Business Tags

This chapter describes how to manage and view business tag information.

• Working with Business Tags, page 10-2, describes how to create a business tag, for example, a 
subscriber to a port. In addition, it describes how to detach a business tag.

• Searching for Business Tags, page 10-3, describes how to find a business tag using the business tag’s 
name and key. 

• Viewing Business Tag Properties, page 10-4, describes how to view business tag properties.

Cisco ANA NetworkVision enables the operator to attach business tags to network objects. A business 
tag is a record, which is stored in the Cisco ANA Gateway database that points to a network object. Each 
business tag has a “key” field, which is a unique identifier for the business tag. The key is common both 
to the Cisco Supervisor and the Northbound OSS applications that are integrated with Cisco.

The tag can be created explicitly, by specifying the network object and the business tag’s details. When 
the system performs an impact analysis report on the affected network objects, if there are business tags 
attached to these objects, the report includes the details.

Cisco ANA Gateway enables business tags to be attached to any managed network object that is 
represented in the Cisco ANA information model. This enables you to:

• Add user familiar labels to network objects, for example, devices and so on.

• Define service endpoints, for example, subscriber and provider connections.

• Click on a hyperlink and go directly to the required location, for example:

– To a specific port.

– To a specific subscriber using the subscriber’s phone number.

Cisco ANA supports the following types of business tags:

• Subscriber

• Provider Connection

• Label

Business tags enable you to perform the following functions: 

• Create a business tag for a network object see Working with Business Tags, page 10-2.

• Search for a business tag and/or generate a list of all the business tags see Searching for Business 
Tags, page 10-3.

• Edit the details of a business tag.

• Remove a business tag. For more information see Working with Business Tags, page 10-2.
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Working with Business Tags 
Cisco ANA NetworkVision enables you to create a business tag, for example, a new subscriber to a port. 
In addition, you can detach existing subscribers from ports.

To attach a business tag:

Step 1 Right-click on a network object in the Cisco ANA NetworkVision window or in any of the dialog boxes 
to display a right-click shortcut menu.

Step 2 From the right-click shortcut menu, select Attach Business Tag. The Attach Business Tag dialog box is 
displayed.

The following fields are displayed in the Attach Business Tag dialog box:

• Unique Key—A unique identifier for the business tag.

• Name—The name of the business tag.

• Type—The related business tag type options, namely, Subscriber, Provider Connection or Label.

• Notes—A free text message.

Step 3 Enter a Key and Name for the business tag.

Step 4 From the Type dropdown list, select the type of business tag (namely, Subscriber, Provider Connection 
or Label).

Note When Label is selected as type the name of the network object changes to display the business 
name.

Step 5 Enter a free text message in the Notes area (optional).

Step 6 Click Save. The business tag is attached to the network object. The business tag is displayed in the 
Business Tag tab of the Inventory window for the selected network object and the name of the business 
tag is displayed in the tree pane, map pane, Cisco ANA PathTracer and so on.

Note The Edit and Detach options are displayed in the right-click shortcut menu when a business tag 
is attached to a network element.

You can search and edit business tag information attached to a network object using tools available from 
the appropriate Business Tag dialog box. A business tag that has been attached to a network object can 
also be detached.

To detach a business tag:

Step 1 Open the business tag that you want to delete by selecting the Business Tag tab of the required network 
object in the Inventory window. On the toolbar, click Detach Business Tag.

or

Right-click on the network object with the business tag in the tree pane or map pane in the Cisco ANA 
NetworkVision window’s workspace to display the General shortcut menu and select Detach Business 
Tag.
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or

Search for the business tag. For information see Searching for Business Tags, page 10-3. Select the 
business tag in the table and click Detach Business Tag.

Note A single or multiple business tags can be detached.

The business tag is detached from the network object and the Business Tag tab is no longer displayed.

Searching for Business Tags 
Cisco ANA NetworkVision enables you to find a business tag, namely, a subscriber, provider connection 
or label using the full or partial business tag name and the business tag key. If you use the full or partial 
business tag name for the search, the search results provide a list of business tags meeting the search 
criteria. If you use the business tag key, the search results provide information about the particular 
business tag.

Note Click on the hyperlink provided in the search results table to go directly to the required location.

To search for a business tag:

Step 1 In the Cisco ANA NetworkVision toolbar, click Find Business Tag,

or

From the Edit menu, select Find Business Tag. The Find Business Tag dialog box is displayed.

The Find Business Tag dialog box contains the following tools:

Note To activate all the business tag tools (toolbar buttons), click on any line in the table of the Find 
Business Tag dialog box.

Table 10-1 Find Business Tag Dialog Box Tools

Button Function

Finds the business tag according to a name, key or type entered in the Find 
Business Tag dialog box.

Clears the search information entered in fields in the Find Business Tag 
dialog box.

Opens the Edit Business Tag dialog box enabling you to edit the business 
tag.

Detaches the business tag. For more information see Working with 
Business Tags, page 10-2.

Opens the online Cisco ANA NetworkVision Help.
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Step 2 Enter the full or partial Key and/or Name for the business tag.

Step 3 From the Type dropdown list, select the type of business tag that you want to find.

Step 4 Click Find. The results of the search are displayed in a table at the bottom of the Find Business Tag 
dialog box.

The following columns are displayed in the table:

• Key—A unique identifier for the business tag.

• Name—The name of the business tag.

• Type—The business tag type, namely, Subscriber, Provider Connection or Label.

• Entity—The location of the network element with the attached business tag, as a hyperlink that 
opens the properties of the relevant location.

Step 5 Click on the hyperlink provided in the search results table to go directly to the required location.

Viewing Business Tag Properties
Cisco ANA NetworkVision enables you to view business tag properties.

To view business tag properties:

Step 1 Select a business tag in the table in the Find Business Tag dialog box.

Step 2 Right-click to display the shortcut menu and select Properties.

or

Click Edit on the toolbar of the Find Business Tag dialog box.

or

Double-click on the business tag in the table. The Business Tag Properties dialog box is displayed.

For more information about the fields displayed see Working with Business Tags, page 10-2.

You can also view the business tag’s properties in the Business Tag tab of the Inventory window.
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 P P E N D I X A

Icon Reference

This appendix provides a quick reference guide to Cisco ANA NetworkVision’s icons.

• Device Icons, page A-1, displays the Cisco ANA NetworkVision device icons and provides a 
description.

• Management State Icons, page A-3, displays the Cisco ANA NetworkVision management state 
icons and provides a description.

• Alarm and Ticket Icons, page A-3, displays the Cisco ANA NetworkVision alarm icon and provides 
a description.

Device Icons 
Table A-1 Device Icons

Tree Pane/ Map 
Pane Description

Unmanaged Network

Network, sub-network or logical aggregation

Router

Generic SNMP

Ethernet Switch

DSLAM 

ATM switch 

BRAS

Ping VNE
A-1
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    Device Icons
Note When Cisco ANA NetworkVision detects a network device for which there is not enough information 
available, the device is displayed as a ghost device on the map. In this case, the user is unable to view 
the ghost device’s properties or communicate with the device. When the ghost device’s information is 
updated, its icon is replaced with the relevant device icon and all the related device information and 
communication become available.

The following icons are used in specific VPN MPLS Service View maps and are displayed in the tree 
and map panes:

Viewable by a user with a higher permission level

Ghost device

Table A-1 Device Icons (continued)

Tree Pane/ Map 
Pane Description

Table A-2 VPN MPLS Device Icons

Tree 
pane Map pane Represents

Root (map name) or aggregation

VPN business element

Virtual Router business element

Site business element

Site business element with an actively associated CE device and 
where the device is hidden

Logical Circuit Aggregator (LCA) business element

Logical Circuit Peer (LCP) business element

LCP business element with an actively assigned tunnel edge for the 
CE device and where the device is hidden
A-2
Cisco Active Network Abstraction NetworkVision User Guide, Version 3.6

OL-12500-01



 

Appendix A      Icon Reference
    Management State Icons
Management State Icons

For more information about management states see Management State, page 2-17.

Alarm and Ticket Icons
The way in which a ticket is displayed in the ticket pane depends on the status/severity of the alarm. The 
alarm displays the severity level of the topmost alarm. 

In the tree pane and ticket pane the  icon is displayed. In the map pane the  icon is displayed. The 
ticket pane icons change when:

• A ticket is generated.

• A ticket is cleared.

• A ticket is acknowledged.

• An up ticket is generated.

• A ticket is cleared and removed.

For more information about severities see Map Pane, page 2-7. 

An example of the appearance of the ticket pane when a ticket is generated is displayed below.

Table A-3 Management State Icons

Tree Pane/ 
Ticket Pane Map Pane Description

Unsupported. The VNE does not support the network object 
hardware or software version or a device module.

Initializing. The VNE or VNE component is in startup mode or 
temporarily non-operational.

VNE Unreachable. Cisco ANA Gateway received no response 
from the VNE.

Device Unreachable. Cisco ANA failed to access the device.

Partially Supported. Partially supported device.

Maintenance. The VNE state was manually changed to 
maintenance.

Table A-4 Ticket Pane Displaying Generated Ticket

Severity Ticket ID Short Description Acknowledged

Major 27 Port down False (Not Acknowledged)
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    Alarm and Ticket Icons
An example of the appearance of the ticket pane when a ticket is cleared is displayed below.

A ticket that has been cleared can be removed from the ticket pane. For more information see Ticket 
Pane, page 2-13.

When a ticket is cleared its definition changes to acknowledged automatically in the ticket pane, namely, 
its definition in the Acknowledged column is true. 

An example of the appearance of the ticket pane when a ticket is acknowledged is displayed below. When 
a ticket is acknowledged it can then be cleared and the severity changes to OK.

Note When a ticket with an Information severity is acknowledged, the ticket is automatically removed from 
the Cisco ANA Gateway and from the ticket pane.

The cause of the alarm is fixed; therefore an ‘Up Ticket’ is automatically generated with an OK severity. 
An example of the appearance of the ticket pane when an ‘Up Ticket’ is generated is displayed below.

The ticket can be removed from the ticket pane when it has been cleared or when an ‘Up Ticket’ is 
generated. The ticket is then removed from the ticket pane and the database.

Approves the reported faulty ticket and clears the faulty networking entity from Cisco ANA. In addition, 
the ticket, all its active alarms and business entities are removed from Cisco ANA Gateway and from the 
ticket pane.

Table A-5 Ticket Pane Displaying Cleared Ticket

Severity Ticket ID Short Description Acknowledged

 
Normal

27 Cleared due to Force Clear True (Acknowledged)

Table A-6 Ticket Pane Displaying Acknowledged Ticket

Severity Ticket ID Short Description Acknowledged

 Major 27 Port up True

Table A-7 Ticket Pane Displaying ’Up Ticket’

Severity Ticket ID Short Description Acknowledged

 
Normal

27 Port up True
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accumulating affected parties 8-2

accumulating affected parties in a correlation tree 8-3

acknowledged tickets 8-16

Acknowledge Ticket, shortcut menu 2-30

acknowledging tickets 8-13

acronyms 1-4

Add Device File menu 2-21

adding, devices 4-5

adding links 7-6

Add VPN File menu 2-21

Advanced tab, Ticket Properties dialog box 8-11

affected pair, viewing reports 8-12

affected parties

accumulating 8-2

accumulating in a correlation tree 8-3

Affected Parties tab,Ticket Properties dialog box 8-8

Aggregate

Aggregated Node shortcut menu 2-28

Device shortcut menu 2-26

Map shortcut menu 2-28

Node menu 2-23

Aggregated Node shortcut menu

Disaggregate 2-28

Filter Tickets 2-28

Remove from Map 2-28

Rename 2-28

Resize 2-28

Save as New map 2-28

Show as Aggregation 2-29

Show Thumbnail 2-29

aggregating, devices 4-16
alarms

definitions 1-3

life-cycle 8-2

overview 8-1

Attach Business Tag, Device shortcut menu 2-26

automatic impact analysis 8-2

B

business tags

searching for 10-3

viewing properties 10-4

working with 10-2

C

calculating impact analysis 7-4

Change User Password, Tools menu 2-24

changing user password 2-31

Cisco.com, Help menu 2-24

Clear, Ticket shortcut menu 2-30

Clear and Remove, Ticket shortcut menu 2-30

cleared tickets 8-16

clearing filter 3-3

clearing tickets 8-14

Close Map, File menu 2-21

closing maps 4-10

collection method, filter links 7-10

Command Builder, overview 1-3

comparing paths 9-14

concepts 1-4

Correlation tab,Ticket Properties dialog box 8-10

counter values, PathTracer, saving 9-13
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CPU usage graph, opening 4-20

creating maps 4-3

customizing NetworkVision 2-31

D

defining filter 3-2

definitions

alarms 1-3

events 1-3

tickets 1-3

deleting maps 4-10

Detach/Edit

Device shortcut menu 2-26

Links View shortcut menu 2-29

device icons A-1

device properties, viewing 5-1

devices

adding 4-5

aggregating 4-16

ping 4-20

removing from a map 4-6

resizing 4-11

Telnet communication 4-21

Device shortcut menu

Aggregate 2-26

Attach Business Tag 2-26

Detach/Edit 2-26

Disaggregate 2-26

Filter Tickets 2-26

Inventory 2-25

Management 2-27

Properties 2-27

Remove from Map 2-26

Resize 2-26

Save as new map 2-26

Tools 2-26

Topology 2-27

VNE Tools 2-27
IN-2
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Device view, NetworkVision window 2-9

disabling port alarms 6-6

Disaggregate

Aggregated Node shortcut menu 2-28

Device shortcut menu 2-26

Node menu 2-23

DLCI/VC/Cross Connect table, opening 6-8

E

events, definitions 1-3

Exit, File menu 2-22

exporting table to a file 3-5

F

filtering

links 4-17

links, using collection method 7-10

tickets by criteria 8-4

tickets by device 8-4

filters

clearing 3-3

defining 3-2

Filter Tickets

Aggregated Node shortcut menu 2-28

Device shortcut menu 2-26

Link shortcut menu 2-29

Map shortcut menu 2-28

Find Business Tag, Edit menu 2-22

finding

link source 4-15

network devices 4-15

text in a table 3-2

ticket source 4-15

Find Source

Links View shortcut menu 2-29

Ticket shortcut menu 2-30
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Index
Fit In Window, View menu 2-22

G

General tab, Ticket Properties dialog box 8-7

generated ticket 8-15

Go to Parent, Map shortcut menu 2-27

Go to Root, Map shortcut menu 2-27

H

History tab, Ticket Properties dialog box 8-7

I

icons

devices A-1

management states A-3

VPN MPLS devices A-2

impact analysis, calculating 7-4

Inventory, Device shortcut menu 2-25

Inventory window

Device View panel 6-4

Device View panel toolbar 6-4

opening 6-1

Properties pane, Information tabs and tables 6-5

Ticket pane 6-5

Tree pane 6-3

L

Link List pane, Link Properties 7-3

Link Properties

Link List pane 7-3

Properties pane 7-3

link properties, opening 7-1
Cisco Active N
OL-12500-01
links

adding 7-6

filtering 4-17

Link shortcut menu

Filter Tickets 2-29

Properties 2-29

link source, finding 4-15

Links view

NetworkVision window 2-11

overview 7-8

Links view shortcut menu

Attach Business Tag 2-29

Detach/Edit 2-29

Find Source 2-29

Properties 2-30

Load Path Tracer, File menu 2-21

logging out 2-32

logical inventory, viewing 6-7

Logical Inventory window 6-7

M

Management, Device shortcut menu 2-27

management state icons A-3

map files in PathTracer, saving 9-12

map layout, defining 4-6

Map pane, NetworkVision window 2-7

maps

closing 4-10

creating 4-3

deleting 4-10

opening 4-2, 4-4

previewing 4-21

printing 4-23

renaming 4-10

saving 4-7

saving, new 4-8

saving as an image 4-8

selecting views 4-14
IN-3
etwork Abstraction NetworkVision User Guide, Version 3.6



 

Index
Map shortcut menu

Aggregate 2-28

Filter Tickets 2-28

Go to Parent 2-27

Go to Root 2-27

Mark as A Side, Node menu 2-23

Mark as Z Side, Node menu 2-24

Menu bar, NetworkVision 2-20

multi-path window, PathTracer 9-4

N

network, viewing 4-12

network devices, finding 4-15

network devices, viewing 4-13

network objects, status 2-15

management state 2-17

new ticket propagation 2-16

propagation 2-15

severity 2-15

tickets 2-18

NetworkVision

customizing 2-31

Edit menu

Find Business Tag 2-22

Find in Map 2-22

Resize 2-22

File menu

Add Device 2-21

Add VPN 2-21

Close Map 2-21

Exit 2-22

Load Path Tracer 2-21

New Map 2-21

Open 2-21

Print 2-22

Print Preview 2-21

Save As Image 2-21

Save Map 2-21
IN-4
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Help menu

About Cisco ANA NetworkVision 2-25

Cisco.com 2-24

Cisco ANA NetworkVision Help 2-24

Menu bar 2-20

Node menu

Aggregate 2-23

Disaggregate 2-23

Inventory 2-23

Mark as A Side 2-23

Mark as Z Side 2-24

Properties 2-24

overview 1-1

starting 2-1

toolbar 2-18

Tools menu

Change User Password 2-24

Options 2-24

Window Menu 2-24

View menu

Fit In Window 2-22

Layout 2-22

Normal Select 2-23

Overview 2-22

Pan 2-23

Zoom In 2-22

Zoom Out 2-22

Zoom Selection 2-23

window 2-5

NetworkVision window

Device view 2-9

Links view 2-11

Map pane 2-7

Ticket pane 2-13

workspace 2-6

New Map, File menu 2-21

Normal Select, View menu 2-23

Notes tab,Ticket Properties dialog box 8-11
sion 3.6
OL-12500-01



 

Index
O

Open, File menu 2-21

opening

CPU usage graph 4-20

DLCI/VC/Cross Connect table 6-8

Inventory window 6-1

maps 4-4

PathTracer 9-2

Port Utilization graph 6-6

selected maps 4-2

ticket properties 8-6

opening link properties 7-1

Options, Tools menu 2-24

overview

Command Builder 1-3

NetworkVision 1-1

PathTracer 1-2

SoftProperties Manager 1-2

Overview, View menu 2-22

P

Pan, View menu 2-23

parties, accumulating affected 8-2

password, changing 2-31

path information, viewing 9-12

paths

comparing 9-14

rerunning 9-14

PathTracer

Multi-Path window

Map pane 9-6

Shortcut menu 9-6

toolbar 9-5

opening 9-2

overview 9-1
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Single-Path window 9-7

File menu 9-9

Help menu 9-10

Layer tabs 9-11

Properties table 9-11

Shortcut menu 9-10

Toolbar 9-9

Tools menu 9-10

topological map 9-11

View menu 9-9

Window menus 9-9

PathTracer, overview 1-2

PathTracer Multi-Path window 9-4

File menu 9-6

Paths pane 9-6

Tabs 9-6

permissions, security 2-3

physical inventory, viewing 6-5

ping devices 4-20

port alarms, disabling 6-6

Port Utilization graph, opening 6-6

preview maps 4-21

Print, File menu 2-22

printing maps 4-23

Print Preview, File menu 2-21

print setup, defining 4-22

Properties

Device shortcut menu 2-27

Link shortcut menu 2-29

Links View shortcut menu 2-30

Node menu 2-24

Ticket shortcut menu 2-31

Properties pane, Link Properties 7-3

R

Remove, Ticket shortcut menu 2-30
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Remove from Map

Aggregated Node shortcut menu 2-28

Device shortcut menu 2-26

removing devices from map 4-6

removing tickets 8-14

Rename, Aggregated Node shortcut menu 2-28

renaming

aggregated node 4-17

maps 4-10

renaming aggregated node 4-17

rerunning paths 9-14

Resize

Aggregated Node shortcut menu 2-28

Device shortcut menu 2-26

Edit menu 2-22

resizing devices 4-11

roles, security 2-3

S

Save As Image, File menu 2-21

Save as New map

Aggregated Node shortcut menu 2-28

Device shortcut menu 2-26

Save Map, File menu 2-21

saving

map as an image 4-8

maps 4-7

new maps 4-8

PathTracer

counter values 9-13

map files 9-12

scopes, security 2-4

searching for business tags 10-3
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overview 2-3

permissions 2-3

roles 2-3

scopes 2-4

selecting map views 4-14

selection filters, setting 3-3

setting selection filters 3-3

severity, updating 8-3

shortcut menus 2-25

Show as Aggregation, Aggregated Node shortcut 
menu 2-29

Show Thumbnail, Aggregated Node shortcut menu 2-29

single-path window, PathTracer 9-7

SoftProperties Manager, overview 1-2

sorting tables 3-4

starting NetworkVision 2-1

status

network objects 2-15

management state 2-17

new ticket propagation 2-16

propagation 2-15

severity 2-15

tickets 2-18

tickets 8-15

T

tables

exporting to a file 3-5

overview 3-1

sorting 3-4

Telnet to devices 4-21

text, find in a table 3-2
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ticket pane

displaying

acknowledged ticket A-4

cleared ticket A-4

generated ticket A-3

up ticket A-4

Ticket pane, NetworkVision window 2-13

ticket properties, opening 8-6

tickets

acknowledged 8-16

acknowledging 8-13

cleared 8-16

clearing 8-14

definitions 1-3

filtering by criteria 8-4

filtering by device 8-4

generated 8-15

removing 8-14

status 8-15

Ticket shortcut menu

Acknowledge 2-30

Clear 2-30

Clear and Remove 2-30

Find Source 2-30

Properties 2-31

Remove 2-30

ticket source, finding 4-15

toolbar

NetworkVision 2-18

Ticket Properties dialog box 8-12

Tools, Device shortcut menu 2-26

Topology, Device shortcut menu 2-27

Tree pane, NetworkVision window 2-6

U

updating severity of an alarm 8-3

Up ticket 8-16

user password, changing 2-31
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viewing

business tag properties 10-4

device properties 5-1

logical inventory 6-7

network 4-12

network devices 4-13

physical inventory 6-5

report for affected pair 8-12

VNE properties 5-3

viewing path information 9-12

VNEs, viewing properties 5-3

VNE Tools, Device shortcut menu 2-27

VPN MPLS device icons A-2

W

working with business tags 10-2

workspace, NetworkVision window 2-6

Z

Zoom In, View menu 2-22

Zoom Out, View menu 2-22

Zoom Selection, View menu 2-23
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